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Getting Started with FARO Insight 

Overview 
This chapter is intended to serve as an introduction to the basics of FARO Insight.  It 
provides a good review for the operator who has had the initial training course on the 
tracker but needs to jog his or her memory.  It is also a good self-taught tutorial for 
operators with no tracker experience who need to figure it out for themselves. 

The information here is presented in a semi-tutorial fashion with a few examples that 
continue throughout the chapter. If you want to take advantage of this feature you 
should glue three flat nests onto a planar surface.  These targets will provide all the 
necessary targeting referred to in the tutorial. 

A working knowledge of Microsoft® Windows NT is assumed.  The explanations are 
detailed, but they may still be too vague for a Windows NT novice.  The best 
resource for Windows NT information is the manual or online help that comes with 
Windows NT. 

Software Installation 

Installing the Software 
It is not necessary to install the software each time you run FARO Insight.  
Instructions for loading FARO Insight onto a new machine or for installing a 
software upgrade accompany the CD. 

Getting Started 

Starting FARO Insight 
You can start FARO Insight using either the mouse or the keyboard.  If you create a 
shortcut to FARO Insight into the Startup group, FARO Insight will run every time 
you start Windows™ NT. 
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To start FARO Insight 
1. Double click on the FARO Insight icon , or use the arrow keys to 

select the FARO Insight icon and press enter. 

It takes a few moments for FARO Insight to load.  The program then 
displays the FARO Insight splash screen. 

 
FARO Insight Splash Screen 

2. To continue, press any key or click on the splash pad. 

Creating a New Job 
For more information on 
opening jobs, see "Job Files 
and Templates". 

FARO Insight stores the name of your most recent data file and loads that file each 
time you run the program.  When you open a new job, FARO Insight automatically 
closes the job that is currently open. 

1. From the File menu, choose New (Alt, F, N) or press the Open New 
Job button . 

 
File Menu 

FARO Insight displays the Create New Job dialog. 
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Create New Job Dialog 

2. In the File Name box, type the name of the file you want to use for this 
job. 

If you want to open the job file in another drive or directory, select a 
drive and directory, or type the complete path in the File Name box. 

3. Choose the ‘Open’ button. 

After a few moments, FARO Insight displays the name of the new file 
in the title bar of the FARO Insight program window. 

Geometric Entities 

The Gents Worksheet 
The Gents worksheet and 
worksheets in general, are 
described thoroughly in 
"FARO Insight Worksheets". 

The Gents (Geometric Entities) worksheet is where geometric features such as lines, 
points, frames, circles, etc., are declared, measured, computed and compared.  Most 
of the work you do in FARO Insight, and all of the measurement work, is performed 
in the Gents worksheet; it is typically the first window you open when starting 
FARO Insight. 

Opening the Gents worksheet 
When you open a new file, FARO Insight closes any worksheets that were open.  
Follow this procedure whenever you open a new job. 

Press the Gents button  on the tool bar.  FARO Insight opens the Gents 
worksheet. 
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The FARO Insight Screen 

If you want the Gents worksheet to fill the entire workspace, click the maximize 
button in the upper-right corner of the worksheet. 

Setting the initial PART scale 
This important concept is 
covered in "Objects, Scale 
and Movement". 

You can set the initial scale of the PART object either by entering its coefficient of 
thermal expansion (CTE) and temperature or by defining the Actual PART frame 
using a best-fit.  This allows you to view the PART object at both Current and 
Reference condition. 

1. From the Orientation menu, choose Material (Alt, N, A), or click the 
Object Material button . 

 
Object Material dialog 

2. From the list of materials, select the PART material, and then choose 
'OK'. 

3. From the Orientation menu choose Temperature (Alt, N, T), or click 
the Object Temperature button . 

FARO Insight displays the Object Temperature Observations dialog. 
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Object Temperature Dialog 

4. Enter the PART temperature, then choose OK. 

FARO Insight automatically recalculates the PART Object scale. 

Declaring Features 
Before you can measure a feature, you must first declare it.  When you declare a 
feature, you tell FARO Insight what type of feature you want to measure, the name 
of the feature, and how the feature is to be measured.  Features can be declared 
offline prior to a measurement where the various parameters can be customized, or 
they can be declared on the fly at the time the feature is measured.  The following 
give examples of how some features are declared. 

Declaring Actual points 
In this procedure, we will declare four points ‘p1’ through ‘p4’. 

1. From the Feature toolbar select ‘Point’ from the first dropdown list. 

2. Select ‘Actual’ from the second dropdown list. 

3. Enter the name of the feature, in this case ‘p1’, in the third field.  You 
may also accept the default value if desired. 

4. In the fourth field enter the number 4.  This will determine the number 
of features you wish to create. 

5. In the fifth field select ‘StdPoint’ as the method by which the features 
will be measured. 

6. The feature toolbar should appear as follows: 

 
Feature toolbar set to create point ‘p1’ 

7. Click the Create Features button  from the Feature toolbar. 

Four point features named p1, p2, p3, and p4 will now appear in the 
Geometric Entities sheet. 

Declaring an Actual Plane 
In this procedure, we will declare the plane ‘Plane1’. 

1. From the Feature toolbar select ‘Plane’ from the first dropdown list. 
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2. Select ‘Actual’ from the second dropdown list. 

3. Enter the name of the feature, in this case ‘Plane1’, in the third field. 

4. In the fourth field enter 1. 

5. In the fifth field select the ‘SurfaceScan’ method.  

6. The feature toolbar should appear as follows: 

 
Feature toolbar set to create plane ‘Plane1’ 

7. Click the Create Features button  from the Feature toolbar. 

The feature ‘Plane1’ will now appear in the Gents sheet. 

Operating the tracker 

Setting up the FARO Laser Tracker 
The procedure for setting up, checking and calibrating the tracker can be found in 
Guides located in the Appendix of the FARO Laser Tracker Operators Guide.  
Before the tracker is used for inspection, these procedures should be performed to 
verify that the tracker is operating optimally. 

Communicating with the tracker 
The FARO Insight software communicates with the tracker over a network using an 
Ethernet connection.  You must connect to the tracker before commanding it from 
within FARO Insight. 

Connecting to the tracker 
You can not access any measurement functionality unless you have connected to the 
tracker. 

If you are starting a new job or are working from a job file that has never been used 
to run a tracker, you will need to activate the Station before connecting to the tracker.  

To activate the station: 

1. Open the Geometric Entities worksheet. 

2. Open the Edit Properties dialog box for the feature ‘@STATION01.’  
Select @STATION01 and select Edit, Properties… (Alt E, T) from the 
menu option or by using the speed menu. 

FARO Insight displays the Edit Properties dialog. 
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Edit Properties dialog 

From the ‘Instrument’ dropdown menu, select the tracker that you will 
using and click OK to close the window.  The trackers available in the 
instrument list are created in the Hardware Manager. 

3. With the ‘@STATION01’ cell still highlighted, from the Edit menu 
select Activate Station (Alt E, V) or right-click on the ‘@STATION01’ 
cell and select Activate. 

Note:  You can avoid the activation process for new job files if the default properties 
for a Station are configured to have FARO Insight automatically assign the correct 
tracker and activate it. 

To connect to the tracker: 

1. Connect the computer to the tracker using the networking cable. 

2. From the Tracker menu choose Connect (Alt T, C), or click the 
Connect button . 

It will take a few moments for the computer to connect to the tracker.  
When FARO Insight has successfully completed connected, the 
Connect button will change to the Disconnect button . 

When connection in is successful, a message indicating the IP Address 
appears on the status bar.  The actual numbers that appear will be 
different than the numbers shown in the example.  The actual numbers 
you see will indicate the IP Address of the tracker that you have 
connected to.  

 
Successful Connection message 
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Disconnecting from the tracker 
You should disconnect from the tracker before closing FARO Insight. 

• From the Tracker menu choose Disconnect (Alt, T, D), or click the 
Disconnect button . 

It takes a few moments to disconnect from the tracker.  When you are disconnected 
from the tracker, most of the Tracker Toolbar buttons will no longer be enabled. 

Adding a tracker to the Hardware Manager 
You cannot define a Station as a particular tracker until you’ve defined that tracker 
in the Hardware Manager. 

1. From the Tools menu select Hardware Manager then Trackers (Alt L, 
H, T). 

FARO Insight displays the Hardware Manager dialog. 

 
Hardware Manager dialog 

2. Click on the ‘Add’ button.  FARO Insight displays the Add Tracker 
dialog box. 

 
Add Tracker dialog 

Choose the Type of Tracker you are adding from the ‘Type’ field, enter 
the in the Name of the tracker in the ‘Name’ field and then enter the IP 
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address of you Tracker in the ‘IP Address’ field.  Click OK when 
finished. 

3. Click OK on the Hardware Manager. 

The Tracker Toolbar 
The use of the tracker is 
described in more detail in 
"Tracker Basics". 

The Tracker Toolbar gives you access to the most common tracker functions.  You 
can initiate a measurement, home or reset the tracker, aim the tracker to a known 
position, set the distance, clear observations, measure a level plane, and perform the 
operator checks, all from the tracker toolbar.  Other tracker functions are accessed 
from the Tracker menu. 

Opening the tracker toolbar 
The tracker toolbar can be displayed on top of any other windows or worksheets in 
the FARO Insight workplace or docked to the toolbar portion of the workspace.  You 
can move the tracker toolbar if it gets in the way.  Most of the buttons on the tracker 
toolbar will only be accessible after the user has logged in to the tracker. 

From the View menu select Toolbars, Tracker (Alt, V, T, R). The tracker toolbar will 
appear as follows: 

 
Tracker toolbar 

You can position the tracker toolbar anywhere on the screen. If you close the tracker 
toolbar, it will reappear in its previous position when you reopen it. 

Sending the tracker home 
If you break the laser beam, you must reset the interferometer counter at a known 
distance from the tracker.  

1. Place the SMR in the Tracker Mounted Reset (TMR). 

2. On the Tracker toolbar, press the Home button  or press F9. 

It takes about one second (when ADM is not enabled) for the laser to 
reset. 

Measuring with the tracker 
The features you measure with the tracker fall into two categories: discrete and 
continuous.  Point locations such as tooling holes and drift points are discrete 
features; all other features such as lines, planes, circles, spheres and general surfaces 
are continuous, since they are comprised of multiple points. 

Measuring points 
Points are discrete features: they consist of a single X, Y, Z value. 

1. Open the Tracker toolbar and home the laser. 

2. In the Gents worksheet, set focus on the point ‘p1’. 
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It is not necessary to click directly on the features name; you can click 
anywhere on that row. 

3. Track the SMR to the point you want to measure, and place it in the 
appropriate nest or tooling. 

4. From the Tracker menu, choose Measure (Alt, M), click the Measure 
button  on the Tracker toolbar, or press F3.  FARO Insight will 
initiate the measurement immediately, and display the Measure dialog. 

 
Measure dialog 

5. While measuring, the red light on the tracker will light up.  When the 
light turns off, the measurement is complete, and the coordinates are 
displayed in the X, Y, and Z columns of the Gents sheet.  The Measure 
dialog will close when the measurement is finished. 

6. Repeat steps 1 through 4 for points ‘p2’ and ‘p3’. 

7. Track the SMR back to the Home position (in the TMR) and check 
closure.  To do this, go to the Tracker menu, Closure (Alt, O).  You can 
also press on the Check Closure button,  on the Tracker toolbar.  

FARO Insight displays the Closure window. 

 
Closure Window 

When the SMR is in the Home position the Closure should be zeroed 
and appear as it does above. 

Measuring a plane 
Planes are continuous features that consist of multiple points.  For this example you 
will need a flat surface on which to measure a plane.  For this demonstration, the 
surface does not need to be perfect. 

1. Open the Tracker toolbar and send the Tracker Home. 

2. In the Gents worksheet, focus on the plane ‘Plane1’. 

3. Press the Measure button  on the Tracker toolbar. 
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FARO Insight displays a message indicating it is ready to measure the 
point. 

4. Track the SMR to a flat surface such as a table and hold it in contact 
with the surface. 

5. To begin the measurement, press ENTER, or click the ‘OK’ button 
with the mouse. 

6. Move the SMR smoothly over the surface, making sure to maintain a 
continuous line-of-sight to the SMR. 

While measuring, the red light on the tracker will light up.  When the 
light turns off, the measurement is complete.  When the plane fit is 
done, the feature values are displayed in the Gents worksheet. 

7. Track the SMR back Home and check closure. 

Working with Frames 

Overview 
The chapter "Intuitive 
Function Definition" explains 
how to assign functions and 
describes each frame function 
in detail.  The use of the 
Display frame is described in 
"The FARO Insight 
Interface". 

A frame is a three-dimensional reference system, also referred to as a Cartesian 
coordinate system, in which geometric features such as points, lines, circles, etc., are 
displayed or resolved.  When you open a job, the view frames ‘@STATION01’ and 
‘PART’ are automatically defined.  The @STATION01 condition is the base 
coordinate system that is associated with an instrument at a specific location.  For 
example, the condition @STATION01 is a view frame for an instrument at a specific 
location at a specific time.  Subsequent stations will be ‘@STATION02’, 
‘@STATION03’, etc.  The PART frame is a user definable frame that can be 
assigned any one of the nine creator frame functions provided in FARO Insight. 

Creating an Origin-Point-Point frame 
This procedure explains how to create a frame from the three points ‘p1’ through 
‘p3’ that you previously measured. 

1. In the Gents worksheet, set focus on the frame ‘PART’ for the 
associated with the Actual Set. 

2. Use the right mouse button to access the speed menu and select Edit 
Functions. 

FARO Insight displays the Function Editor. 
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Function editor dialog 

3. Select the Add Function button . 

FARO Insight displays the Select Function dialog. 

 
Select Function dialog 

4. Select ‘Frame from Origin Point Point’ from the function list. 

FARO Insight inserts the OPP function and lists the six arguments 
labeled Point,  Point,  Point, Primary axis, Secondary axis and 
Handedness. 
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Part frame programmed using OPP function 

5. Select the first Point argument in the left pane. 

FARO Insight displays the Argument Parameters form in the right 
pane. 

 
Argument Parameter dialog 

6. Set the object Tag to ‘Point | Actual | p1’ by selecting Point from the 
Feature Type list, ‘Actual’ from the button, and ‘p1’ from the Feature 
Name list. 

7. Repeat steps 5 and 6 for the second and third cells labeled Point, using 
points ‘p2’ and ‘p3’ in respectively. 

8. Select the Primary Axis argument. 

FARO Insight displays the Select an Axis controls in the Argument 
Parameter form. 

 
Axis selection control 
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9. Select  ‘+X’ to indicate that the primary axis (defined by point ‘p2’) is 
the X-axis. 

10. Repeat steps 8 and 9 for the Secondary Axis Argument, choosing 
‘+Y’ as the secondary axis. 

11. Select the Handedness argument. 

FARO Insight displays the Handedness controls in the Argument 
Parameter form. 

 
Handedness control 

12. Select ‘Right’ to indicate that the coordinate system is right-handed. 

13. Select the Save and Close button  to return to the Gents worksheet. 

14. FARO Insight displays the following message asking whether or not 
you would like to view all of the data in the newly constructed Part 
Frame. 

 
View Frame Message 

15. Click the ‘Yes’ button. 

FARO Insight resolves all features in the Gents worksheet in the PART 
frame. 

Notice that all three coordinates of ‘p1’ are zero, the x and z values of 
‘p2’ are zero, and that only the z value of ‘p3’ is zero. This is because 
‘p1’ is at the origin, ‘p2’ lies on the x-axis, and ‘p3’ lies in the x-y 
plane of the PART frame. 

Changing the View frame 
You can resolve the display (view) in any coordinate frame that has been defined and 
calculated.  When you change the view frame, FARO Insight resolves all displayed 
features in the new view frame.  In the previous step FARO Insight prompted the 
user to automatically update the view frame.  To change back to the original setting, 
use the following procedure. 

1. From the View menu, select Toolbars then Display Settings (Alt, V, T, 
P), or click the Display Settings button . 

FARO Insight opens the Display Settings Toolbar. 

 
Display Settings Toolbar 
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2. In the DISPLAY FRAME dropdown menu, choose ‘@STATION01’ 

FARO Insight resolves all features in the Gents worksheet in the 
default tracker frame @STATION01. 

3. Repeat steps 1 and 2 selecting the PART frame in step 2 instead of 
@STATION01. 

4. The Display Settings may also be changed from the View menu by 
selecting Display Settings (Alt V, D). 

FARO Insight opens the Display Settings Window. 

 
Display Settings dialog 

5. In the DISPLAY FRAME dropdown menu, choose ‘@STATION01’ 

FARO Insight resolves all features in the Gents worksheet in the 
default tracker frame @STATION01. 

6. Repeat steps 4 and 5 selecting the PART frame in step 2 instead of 
@STATION01. 

Scalar Entities 
The Sents worksheet, and 
worksheets in general, are 
described thoroughly in 
"FARO Insight Worksheets" 

The Sents (Scalar Entities) worksheet is where scalar features such as angles and 
distances are declared, computed and compared.  If you want to find the angle 
between two measured planes or the distance between two features, you will do so in 
the Sents worksheet. 

The Sents Worksheet 

Opening the Sents worksheet 
1. From the View menu choose Scalar Entities (Alt, V, C) or click the 

Sents button  on the Standard toolbar. 

2. FARO Insight opens the Sents worksheet. 
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Scalar Entities Worksheet 

Computing Angles and Distances 
Before you can calculate a scalar entity, you must declare it.  When you declare a 
feature, you tell FARO Insight what type of feature you want to compute the name of 
the feature, and how the feature is to be evaluated.  This procedure describes how to 
calculate the distance between two points. 

1. Change feature type to Distance by selecting Distance from the drop-
down list above the Type column. 

2. In the Name column, type the name of the Distance, for example ‘d1’. 

3. Press ENTER on the keyboard. 

4. Double-click in the Actual column of the distance ‘d1’. 

FARO Insight displays the Function Editor. 

 
Function editor 

5. Select the Add Function button . 

FARO Insight displays the Select Function dialog. 
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Select Function dialog 

6. Select the function ‘3D Distance between Two Points’ from the 
function list. 

FARO Insight inserts the ‘3D distance between ‘Two Points’ function 
and lists the two point arguments 

 
Function dialog 

FARO Insight displays the Argument Parameters form in the right 
pane. 

7. Select the first Point argument in the left pane. 
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Function Argument dialog 

8. Set the object Tag to ‘Point | Actual | p1’ by selecting Point from the 
Feature Type list, ‘Actual’ from the button, and ‘p1’ from the Feature 
Name list. 

9. Repeat steps 7 and 8 using ‘p2’ for the second point argument. 

10. Select the Save and Close button  to return to the Sents worksheet. 

Notice that the distance calculated is equal to the X value of point ‘p2’. 

Using Watch Windows 

Overview 
Watch Windows are described 
thoroughly in “FARO Insight 
Worksheets”. 

Watch windows display a real-time comparison between the current position of the 
SMR and an Actual or Nominal value of a feature.  For example, when checking 
drift, you can watch the actual (previously measured) position of a point to determine 
whether the tracker (or part) has moved since the point was first measured.  On the 
other hand, by watching the nominal (design) coordinates, you can set a detail by 
moving the SMR until the difference from nominal is zero. 

Checking for drift 
In order to monitor drift, you need to first measure at least three points whose 
positions are stable with respect to both the part and the tracker.  For geometric 
reasons these points must not lie on or near a straight line.  This procedure describes 
how to check drift at the points ‘p1’ through ‘p3’. 

1. In the Gents worksheet, set focus on the Actual value of point ‘p1’. 

2. Track the SMR to point ‘p1’ and place it in the nest. 

3. Press the Watch Window button , or press F4 to launch the watch 
window. 

FARO Insight displays the X, Y and Z differences between the 
measured location of ‘p1’ and the current position of the SMR. 
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Watch Window 

4. Inspect the differences in X, Y, and Z between the current and previous 
coordinates.  If these differences are large, either the tracker or the 
point has moved since it was measured. 

5. For points ‘p2’ and ‘p3’, repeat steps 1 through 4. 

Watching a plane 
When you open a watch window on a feature such as a plane, FARO Insight 
compares the position of the SMR to the measured plane and displays the distance 
from the SMR to the closest point of approach on the plane. 

1. Focus on the Actual plane ‘Plane1’ in the Gents worksheet. 

2. Track the SMR to the plane ‘Plane1’ and hold it there. 

3. Press the Watch Window button , or press F4 to launch the watch 
window. 

FARO Insight displays dN, the distance from the measured plane to the 
closest point of approach of the SMR.  Notice how this value changes 
as you move the SMR over the plane.  Slip a shim of known thickness 
under the SMR and note the change dN. 

Changing Watch Settings 
When a Watch Window is open it is possible to change its parameters to display all 
coordinates as in 3D or just specific coordinates such as dX, dY or dZ. 

1. From the Settings menu, click on Watch (Alt S, W).   If a Watch 
Window is open, right-click anywhere inside the Watch Window to 
open the same dialog box. 

FARO Insight displays the Watch Settings dialog box. 
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Watch Settings Dialog 

2. For Points, you may display specific components (3D, dX, dY, and dZ) 
by checking the corresponding box(es) in the 3D Vector Components 
portion of this window. 

3. For features that have a radial component (circles, spheres, etc.) you 
may display specific components (dR, dR_X, dR_Y, and dR_Z) by 
checking the corresponding box(es) in the Radial Components portion 
of this window. 

4. The same may be done for features that have normal components 
(planes, circles, etc.).  To display specific components (dN, dN_X, 
dN_Y, and dN_Z) check the corresponding box(es) in the Normal 
Components portion of this window. 

5. You may also configure this window to apply an offset (for tooling). 
The Closest Point of Approach (CPA) coordinates may be displayed as 
well as Build Arrows for use in the Graphics Window.  For more 
information on Build Arrows, see the Watch Windows with a Tolerance 
section of the Graphics View Window chapter.  

Viewing and Graphing Observations 

Observations 
Graphing and Observation 
windows are described 
thoroughly in "FARO Insight 
Worksheets". 

When you scan an object such as a circle or plane, FARO Insight displays only the 
essential information in the Gents sheet such as position and a vector.  The 
potentially hundreds or thousands of observations that make up the feature are stored 
separately within FARO Insight.  For any measured feature, the user can view the 
individual observations. 

Viewing a feature’s observations 
Storing and viewing observations separately allows you to concentrate on the bigger 
picture - like thinking of a circle as an individual entity, rather than as a collection of 
hundreds of points - and still have access to the details when you need them.  This 
procedure describes how to view the observations of plane ‘Plane1’ that was 
measured previously. 

1. Set focus on the Actual plane ‘Plane1’ in the Gents worksheet. 
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2. Click on the Actual plane ‘Plane1’ using the right mouse button and 
selecting Observations from the speed menu, or select the Observations 
button  from the toolbar. 

FARO Insight displays the Observations worksheet. 

 
Observations worksheet 

Clearing observations 
If you make a mistake while measuring a feature, such as lifting the SMR off the 
surface while scanning a plane, you can clear the bad observations and re-measure 
the feature. 

1. In the Gents worksheet, set focus on the Actual feature whose 
observations you want to clear. 

2. From the Edit menu choose Clear Obs. (Alt, E, B), click the Clear Obs 
button , or press F7. 

3. FARO Insight prompts you to verify your selection. 

4. Choose ‘Yes’ to clear the feature’s observations. 

Graphing observations 
When you scan a feature such as a circle, line, plane or sphere, you often want to 
view and plot the residuals from the feature fit.  Graphing is also a quick way to 
check trends such as the straightness of a line.  This procedure describes how to plot 
the normal residuals from the plane ‘Plane1’ that was measured previously. 

1. Open the Observation window for the feature whose observations you 
want to plot. 

2. Select the dN column by clicking on the column header. 

3. Click the Graph button . 

4. FARO Insight displays a plot of the planes residual errors. 
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 Sample Plot of Observations 

Quitting FARO Insight 

Closing FARO Insight 
FARO Insight automatically saves any changes made to the job file, making 
unnecessary for you to do so.  However, before you exit FARO Insight, it is 
recommended that you disconnect the tracker. 

1. From the Tracker menu choose Disconnect (Alt, T, D), or press the 
Disconnect button . 

2. From the File menu choose Exit (Alt, F, X). 
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Job Files and Templates 

Job Files 
All job files in FARO Insight are given a default extension of .SMX.  The .SMX file 
is a compressed file containing the three files that make up your job.  When you open 
the .SMX file in FARO Insight, you are decompressing the file and creating working 
files in the same directory as the *.SMX file.  After FARO Insight decompresses the 
.SMX file, it opens the following working files: a database file, a job description file, 
and an index file.  The database file (*.DTA) contains the actual observations, the 
functional relationships between the data, and feature information such as offset and 
method definitions.  The index file (*.IDX) contains FARO Insight directory of 
features in the database file, and the summary file (*.SMY) contains information 
such as job specific to the inspection, such as the date, the company name and 
operators.  When you close a job, FARO Insight compresses these files to create the 
.SMX file. 

Creating a New Job 
When creating a new job, FARO Insight allows you to select the name of the file, 
and the drive and directory in which it is stored.  The user can also create new 
folders and change the display view directly through the Create New Job dialog box 
using a typical Microsoft interface.  After the job is created, FARO Insight closes 
the job that is currently open and opens the newly created job.  The new job file will 
automatically be given an extension of .SMX. 

You can not create a new job using the name of an existing job in the same directory. 

1. From the File menu, choose New (Alt, F, N) or press the Create New 
Job button . 

FARO Insight displays the Create New Job dialog. 
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Create New Job dialog 

2. In the File Name box, type the file name you want to use for this job. 

3. FARO Insight creates the job file in the current drive and directory and 
adds the filename extension .SMX. 

4. If you want to create the job file in another drive or directory, select the 
drive and directory, or type the complete path in the File Name box. 

5. Press the OK button. 

Opening an Existing Job 
FARO Insight stores the name of your most recent job file in the INSIGHT.INI file, 
and automatically loads that file each time you run the program.  If you want to 
continue working on that job, you are ready to begin as soon as the program loads. 
Or, you can open another job you had previously created, and continue working on 
that job. 

To open an existing job 
FARO Insight stores all the information related to each job in separate files.  The 
user can resume work on an existing job at any time simply by opening that job file.  
When the operator opens an existing job, one can pick up where the job was left off.  
As with the Create New Job dialog box, the user can create new folders and change 
the display view directly through the Open Job dialog box using a typical Microsoft 
interface. 

1. From the File menu, choose Open (Alt, F, O), or press the Open Job 
button . 

FARO Insight displays the Open Job dialog box. 

 
Open Job dialog 

2. To select the file to open, you can double-click the name on the file 
name list, type the filename in the file name box, or press the UP or 
DOWN arrow keys and press enter. 
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3. If the job you want to open is on another drive and/or directory, either 
choose the appropriate drive/directory, or type the complete path in the 
File Name box. 

4. Click the ‘OK’ button. 

5. If you would like to see job specific information for a pre-existing job 
file without opening it, you can click the ‘Summary’ button.   See the 
“File Summary” section in this chapter for more information on the 
‘Summary’ button. 

Saving a Job 
You will notice that there is no Save function within FARO Insight; saving is not 
necessary.  FARO Insight automatically saves all observations, functions, methods 
and offset definitions, and all other information such as comments and manually 
input coordinates as you enter them.  This way, if you accidentally lose power, there 
is no loss of data.  It is possible, however, for an abnormal termination to corrupt 
your database.  For this reason, it is advised that you periodically make a backup file 
to protect your data. 

Saving a Job under a New Name 
To save the current job file under another name and make it the currently active job, 
use the Save As command from the File menu.  For example, you may wish to 
change the name of the current job file from 'Job1' to 'Job2' and continue working in 
'Job2' 

1. From the File menu, choose Save As (Alt, F, S). 

FARO Insight displays the Save As dialog. 

 
Save Job As dialog 

2. In the File Name box, type the new name for the file. 

3. If you want to save the file to another drive or directory, either select a 
drive and directory in the dialog or type the complete path in the File 
Name box.  

4. Click the ‘Save’ button. 

5. The new job name will appear in the title bar of the main window. 
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Make a Backup Copy of a Job 
To save a copy of the active job and continue to work in the original job, use the 
Save As command with the ‘Save file as a backup copy’ option checked.  For 
example, you would save 'Job2' as 'Job2a' but continue working in 'Job2'. 

1. From the File menu, choose Save as (Alt, F, S). 

FARO Insight displays the Save As dialog. 

 
Save Job As dialog 

2. In the File Name box, type the new name for the file. 

3. Check the ‘Save file as backup copy’ box. 

4. If you want to save the file to another drive or directory, either select a 
drive and directory in the dialog or type the complete path in the File 
Name box.  

5. Click the ‘Save’ button. 

Auto Backup 
During the course of a measurement session, you should periodically backup the 
current job.  All computer systems are subject to failures related to either hardware 
or software.  Some failures may result in the loss of data.  To safeguard against loss 
of data, FARO Insight automatically creates a backup copy of the active job file.  If 
an error occurs during a job, the backup copy of the job may be opened and all 
previously recorded data may be recovered. 

Configuring Auto Backup 
The Auto Backup feature may be disabled or modified by opening the Backup 
Configuration dialog box. 

1. From the Settings menu, select Backup (Alt S, B). 

FARO Insight will display the Backup Configuration dialog 
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AutoBackup Configuration dialog 

2. To enable Automatic Backup put a check mark in the Check box 
labeled Enable Automatic Backup. 

3. In the field labeled Interval, enter the time in minutes you wish FARO 
Insight to backup the file. 

4. In the field labeled Backup Directory enter the path on your computer 
were you want the backup file to be stored.  This directory must already 
exist on the computer; FARO Insight will not create it. 

Backup files are created in this directory using the current job file name 
but replacing the first letter of the extension with the ~ character. For 
example Job1.SMX would be saved in the backup directory as 
Job1.~MX. 

Restoring a Backup File after a Failure 
If FARO Insight terminates improperly for any reason the following message will 
appear the next time the program is started. 

 
Database Failure warning 

Ignore the warning and attempt to open the file.  
Continues loading the original job and displays a message that prompts the user to 
disable the initial Auto Backup upon reentering the job. 
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Notification of AutoBackup being disabled 

When FARO Insight terminates improperly, the current job file may be corrupted.  
Because of this, Auto Backup is automatically turned off so that the remote 
possibility of the backup file being overwritten by a corrupt job file does not exist.  It 
is recommended that you enable automatic backup when you are satisfied that you 
corrent job file has not been corrupted due to improper termination.  Auto Backup 
can be enabled through the Settings, Backup…. Menu (Alt, S, B) menu. 

Restore the file from the backup directory – some data may be lost. 
Restores the job from the backup file from the backup directory.  This option 
overwrites the original job with the backup. 

Browse for a different file to open. 
Allows the user to open another existing job. 

Create a new file and open it. 
Allows the user to create a new job. 

Exit FARO Insight without openeing any files. 
Exits FARO Insight. 

Manually Restoring a Backup File 
A backup file can be manually restored using Microsoft Explorer; copy it from the 
backup directory to a new directory and rename it with the .SMX extension. 

Deleting Job Files 
You can delete obsolete or duplicate job files directly from FARO Insight. 

Warning:  A file deleted in this manner is not sent to the Windows Recycle Bin and 
cannot be restored. 

Deleting a job file 
If you delete a job file, it is removed from the hard disk. If you simply want to clear 
the observations from a job, see to “Clearing and Deleting Observations” for more 
information. 

1. From the File menu, choose Delete (Alt, F, L). 

FARO Insight displays the Delete Job dialog. 
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Delete Job dialog 

2. To select the file to delete, you can double-click the name in the file 
name list, type the name in the file name box, or press the UP and 
DOWN arrow keys, to select the file name and press ENTER. 

3. If the job you want to open is on another drive and/or directory, either 
choose the appropriate drive/directory, or type the complete path in the 
File Name box. 

4. Click the ‘Delete’ button. 

5. If you would like to see job specific information for a pre-existing job 
file without opening it, you can click the ‘Summary’ button.   See the 
“File Summary” section in this chapter for more information on the 
‘Summary’ button. 

File Summary 
The File Summary provides a way to maintain non-measurement information 
pertaining to the current job file such as filename, date, and operators.  Also, a brief 
description of the job, comments, company name and company information can be 
entered.  This information will appear on a report’s coversheet and/or in the headers 
or footers of report pages. 

To enter file summary information 
1. From the File menu, select Summary… (Alt, F, M). 

FARO Insight displays the Summary dialog box. 

 
Summary dialog 
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By default, the File tab will be active.  This will display general job 
information that cannot be edited by the user.  The time/date stamp will 
reflect the time in which the job was first created.  If the user performs 
a ‘Clear All’ (see the section on “Clearing ALL Observations in a File” 
in the “FARO Insight Worksheets” chapter), all measured data will be 
erased and a new time/date stamp will be issued. 

2. For the Company Name, Company Information, Operators, 
Description, and Comments tab, input the job information. 

3. Click the ‘OK’ button when finished. 

Job Templates 

What are Templates? 
Job files store not only recorded observations, but also all programming associated 
with each feature.  The record of the features, their methods, and the functional 
relationships between features comprise a job template; the recorded observations 
are the data upon which the template operates. 

For example, if you measure two lines using the StdScan method and then compute 
the angle between them, the job file contains a record of how the lines were 
measured (the method) and how the they were used to compute an angle (the 
function).  This information remains in the job file even if the observations are 
removed.  In fact, you can program the entire job without measuring a single feature. 

This is a rather simple example, but the idea extends to other cases. If you perform a 
complex inspection, all the information necessary to execute the same inspection is 
stored in the job file.  To repeat the inspection, all you must do is clear the 
observations and re-measure the necessary features.  There is no need to re-program 
job.  This ability saves time and ensures consistency between inspections. 

Creating and Using Templates 
There are two ways to create a job template: by programming the job file from 
scratch, or by clearing the observations from an existing job.  It’s not an either/or 
situation, however.  You can always modify the original job file, or add features ‘as 
you go.’  Either way, you end up with a file that contains the necessary information. 

Creating a template from scratch 
The benefit to creating a template from scratch is that it forces you to think through 
the entire job, thereby reducing measurement time. 

1. Define any methods and offsets that will be required. 

2. Declare all of the fundamental geometric features - those which will be 
measured - and assign their methods. 

3. If necessary, declare any Scalar entities such as distances and angles 
that are required in function definitions. 

4. Declare the geometric features that will be evaluated from functions 
based on the fundamental geometric features. 

5. Declare any Scalar entities that will be evaluated from functions based 
on the geometric features declared in step 4. 
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Steps 4 and 5 can be iterative, depending on the complexity of the 
template.  The rule is that you must declare a feature before it can be 
used to define a function. 

Creating a template from a job file 
The easiest way to create a template is to clear the measured data from a job file you 
have already successfully executed.  Using this approach, you edit the template ‘as 
you go,’ thereby working out any bugs in the inspection sequence. 

1. Execute a measurement job as you normally would, by measuring and 
calculating all the necessary features. 

2. Make a backup copy of the completed job. This is very important. 

3. If you want to make the backup copy into a template, open the backup 
copy. Otherwise, leave the current job file open. 

4. From the Edit menu choose Clear All (Alt, E, A). 

FARO Insight prompts you to verify your choice. 

 
Clear all warning message 

5. Press ‘OK.’ 

FARO Insight will clear all measurements from the current job. 

Using a template 
When you open a job based on a template, it is important that you work with a copy 
of the template, rather than the template file itself.  If you forget to work on a copy, 
you can always create a template from the new file. 

1. Open the template upon which you want to base the new job. 

2. Save the template using the name of the new file. 

3. Verify that the file name displayed in the FARO Insight title bar is 
correct.  You are now ready to begin measuring. 
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The FARO Insight Interface 

The FARO Insight Workplace 

Overview 
FARO Insight is a procedurally driven toolbox of functionality whose features are 
accessed through a spreadsheet interface.  This section describes the elements of the 
FARO Insight interface: menus, toolbar buttons, worksheets and windows are all 
explained here, along with a description of how to operate them.  A good 
understanding of the interface is essential for efficient and productive use of the 
software. 

The FARO Insight Screen 
The FARO Insight screen is comprised of the Title Bar, the Menu Bar, and the Work 
Area.  The Title Bar displays the program name and the name of the current job file.  
The Menu Bar displays menu headings such as File, Edit, etc., and the Work Area 
contains the various worksheets and windows employed by the software.  There are 
also a number of additional bars which may be displayed such as Toolbars, which 
display buttons that access the most common functions and features of FARO 
Insight, and the Status Bar which displays various information regarding the status of 
the software and the tracker. 
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FARO Insight Screen 

FARO Insight Menus 

Overview 
The menu provides access to all of the functions in FARO Insight (the tool bars 
provide access to the most common ones).  Functionality is grouped into logical 
categories by heading - the File menu allows you to Open, Save, Print, etc., the 
Settings menu provides access to Units, Defaults, Status Bar, etc., and so on. 

 
Menu Bar 

Using the Menus 
Some menu items carry out an action immediately, such as when you open a watch 
window; others (such as choosing Edit, Method) display a dialog that allows you to 
provide additional input. 
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Example Menu 

To choose a command using the mouse, click the name of a menu on the menu bar, 
then click the command name.  To close a menu without choosing a command, click 
outside the menu. 

To choose a command using the keyboard, press ALT to make the menu bar active, 
then press the key corresponding to the underlined letter in the command name.  To 
close a menu without choosing a command, press ESC. 

To choose a command using shortcut keys (not available for all commands), press 
the key or combination of keys listed next to that command on the menu.  For 
example, you can press F3 to initiate a measurement. 
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File Menu 

 

New… 

Open… 

Save As… 

Delete… 

Summary… 

Import 

Export 

Print Setup… 

Print Preview… 

Print… 

Exit 

Creates a new job file. 

Opens an existing job file. 

Saves the current job under a new name. 

Deletes a job from disk. 

Describes the current job information. 

Imports an ASCII, IGES or CATIA file. 

Exports data to a file. 

Changes settings for the printer. 

Previews what is to be printed. 

Prints to a printer. 

Exits FARO Insight. 

File - Import Menu 

 

Standard… 

Enhanced… 

IGES… 

CATIA… 

Imports standard ASCII text files. 

Imports ASCII data and creates features. 

Imports an IGES formatted CAD model. 

Imports CATIA *.MOD(EL) and *.EXP files. 

File - Export Menu 

 

Text… 

Report… 

Microsoft Excel®… 

CATIA… 

C3DF… 

NURBS Surface… 

Point Clouds… 

Exports selected cells to an ASCII text file. 

Exports data in a Report window to an ASCII text file. 

Exports data in a Report window to Microsoft Excel. 

Exports to a CATIA file. 

Exports data to a C3DF report. 

Exports NURBS surfaces. 

Export point cloud data as text or as an IGES file. 
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Edit Menu 

 

Feature… 

Cell 

Recalculate 

Copy 

Paste 

Paste Special 

Delete 

Clear Observations 

Clear All 

Use Observations 

Un-use Observations 

Functions… 

Properties… 

Method… 

Offset… 

Activate Station 

Close Station 

Edits a feature fit or normalize a vector. 

Edits the contents of a cell. 

Recalculates the selected features. 

Copies the contents of a worksheet cell. 

Pastes the contents of a clipboard into a cell. 

Pastes functions with absolute or relative references. 

Deletes a record from the database. 

Clears a feature’s observations. 

Clears all measured data from a job file. 

Uses an un-used observation. 

Un-uses a used observation. 

Opens the Functions dialog for the selected feature. 

Opens the Properties dialog for the selected feature. 

Opens the Method Manager. 

Opens the Offset Manager. 

Activates the currently selected Station. 

Closes the currently selected Station. 

Edit - Feature Menu 

 

Fit… 

Normalize 

Opens the Fit Options dilaog for the selected feature. 

Normalizes the vector of the selected feature. 
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View Menu 

 

Display Settings… 

Toolbars 

Status Bar 

Graphics 

Geometric Entities 

Scalar Entities 

Results 

Observations 

Readings 

Graph 

Deviations 

Magnify 

Watch 

Watch Nearest Nominal 

Catia Comments Page 

Opens the Display Settings dialog box. 

Opens menu to select toolbars for display. 

Toggles on/off the Status Bar. 

Opens a Graphics window. 

Opens a Geometric Entities window. 

Opens a Scalar Entities window. 

Opens a Results window. 

Opens an Observations window for the selected feature. 

Opens a Readings window for the selected point. 

Opens a graph for the selected column of data. 

Opens a Deviations window for a surface deviation. 

Opens a window on a selected worksheet column. 

Opens a watch window on the selected feature. 

Opens a watch window that goes to the closest nominal. 

Opens a menu to the comments page for imported CAITA files. 

View - Toolbars Menu 

 

Standard 

Feature 

Display Settings 

Orientation 

Function 

Tracker 

Theodolite 

Target Acquisition 

Survey 

Sensor 

Graphics View 

Graphics Settings 

Graphics Active Feature 

Search 

Large Buttons 

Displays the Standard toolbar. 

Displays the Feature Generation toolbar. 

Displays the Display Settings toolbar. 

Displays the Orientation toolbar. 

Displays the Function toolbar. 

Displays the Tracker toolbar. 

Displays the Theodolite toolbar. 

Displays the Target Acquisition toolbar. 

Displays the ADM Survey toolbar. 

Displays the Temperature Sensor toolbar. 

Displays the Graphics View toolbar. 

Displays the Graphics Settings toolbar. 

Displays the Graphics Active Feature toolbar. 

Displays the Search toolbar. 

Displays all toolbars in the large (32x32) format. 

View – Watch Nearest Nominal Menu 

 

Point 

Visible Surface 

Opens a watch window on the nearest nominal point. 

Opens a watch window on the nearest nominal surface. 
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Settings Menu 

 

Units… 

Defaults… 

Backup… 

Rows… 

Columns… 

Status Bar… 

Auto Recalculation 

Auto Advance Anchor 

Temperature Sensors 

Tracker Mode 

Theodolite Mode 

Measurement… 

Bundle… 

Best-fit Frame… 

Watch… 

Watch Nearest Nominal Point… 

Colors… 

Languages… 

C3DF… 

Opens the Numerical Format dialog box. 

Opens the Default Properties dialog box. 

Opens the Backup Configuration dialog box. 

Opens the Sort dialog box for sorting rows. 

Opens the Spreadsheet Column Setup dialog box. 

Opens the Status Bar Options dialog box. 

Toggles on/off automatic recalculation. 

Toggles on/off the Auto Advance option. 

Toggles on/off the use of external temperature sensors. 

Configures FARO Insight to operate laser trackers. 

Configures FARO Insight to operate theodolites. 

Opens the Measurement Tolerance Settings dialog box. 

Opens the Bundle Settings dialog box. 

Opens the Best-fit Frame Settings dialog box. 

Opens the Watch Settings dialog box. 

Opens the Nearest Nominal Point Watch Settings dialog box. 

Opens the Color Settings dialog box. 

Opens the Multi Language Support dialog box. 

Opens the C3DF File Headers dialog box. 
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Tracker Menu 

 

Disconnect 

Connect 

Start… 

Home 

Reset 

Closure 

Measure 

Measure Level Plane… 

Aim… 

Search… 

Set Distance… 

Toggle Sightmode 

Drive Visually… 

 

Drive Manually… 

 

Drive Angles… 

Settings 

Utilities 

Disconnects the FARO Insight from the Tracker. 

Connects FARO Insight to the Tracker. 

Performs a tracker wakeup. 

Resets the tracker at the tracker mounted reset nest. 

Resets the tracker at the designated reset point. 

Opens a Closer window to check interferometer repeatability. 

Initiates a measurement of a selected geometric entity. 

Measures the plane perpendicular to the gravity vector. 

Points the laser at a selected geometric entity. 

Initiates a search pattern to acquire the target. 

Sets the radial distance to the target. 

Toggles the sightmode between Frontsight and Backsight. 

Allows the user to steer the Tracker using the mouse or arrow 
keys. 

Allows the user to steer the Tracker by physically moving its 
head and activates the motors at the posed location. 

Moves the Tracker head to specified azimuth and zenith 
angles. 

Opens menu to adjust various tracker settings. 

Opens menu to run various tracker utilities. 

Tracker - Settings Menu 

 

 

Measurement Probes… 

Temperature Sensors… 

Automatic Backsights 

Opens the Probe Settings dialog box. 

Opens the Remote Temperature Sensors dialog box. 

Toggles on/off automatic backsight measurements. 

Tracker – Utilities Menu 

 

Control Pad… 

Health Checks…. 

Diagnostics… 

Compensation… 

Opens the Tracker Control Pad. 

Opens the Tracker Health Checks. 

Opens the Tracker Diagnostics. 

Allows for compensation of the Tracker. 
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Theodolite Menu 

 

Disconnect 

Connect 

Measure 

Build Mode 

Real Time 

Name Settings… 

Target Thickness 

Disconnects from the Theodolite(s) if connected.  

Connects to the Theodolite(s) not already connected. 

Initiate measurement of point from synchronized Theodolites.  

Enable/Disable Build Mode 

Enable/Disable Read Time Update 

Opens a dialog box to set the naming convention. 

Set Target Thickness 

Orientation Menu 

 

Movements… 

Temperatures… 

Material… 

Scale Constraints 

Common Points 

View Bundle Input… 

Run Bundle 

View Bundle Results… 

View Scale History… 

Opens Object Movements dialog box. 

Opens the Object Temperatures dialog box. 

Opens the Object Material dialog box. 

Opens the Scale Constraints dialog box. 

Opens the Common Points dialog box. 

Opens the Bundle Input window.  

Initiates a bundle calculation.  

Opens a text file containing the job’s bundle results. 

Opens a text file containing the job’s scale history. 

Reports Menu 

 

Standard… 

Custom… 

Settings 

Opens the Standard Report dialog box. 

Opens the Custom Report dialog box. 

Opens a menu to adjust report settings. 

Reports - Settings Menu 

 

Geometric Entities… 

Scalar Entities… 

Observations… 

Surface Deviations… 

Opens the Report Settings dialog box for Geometric Entities. 

Opens the Report Settings dialog box for Scalar Entities. 

Opens the Report Settings dialog box an Observations Window. 

Opens the Report Settings dialog box for a Deviations Window. 
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Tools Menu 

 

Microsoft Excel® Macro… 

Seagate Crystal Reports® 

Layout… 

Automated Survey 

Method/Offset Library… 

Hardware Manager 

Opens a user defined Microsoft Excel. 

Opens menu to either open or create a Seagate Crystal Report. 

Initiates the Layout Wizard. 

Opens menu to ADM surveys 

Opens the Library Management dialog box. 

Opens menu to start the Hardware Manager dialog for a specific tab.  

Tools – Seagate Crystal Reports® 

 

Open… 

Create… 

Opens a dialog used to open saved Seagate Crystal Reports. 

Opens a dialog used to create new Seagate Crystal Reports. 

Tools – Automated Survey Menu 

 

Build 

Inspect 

Monitor 

Settings 

Starts survey to build pre-selected points into position. 

Starts survey for a periodic inspection of pre-selected points. 

Starts survey to monitor drift of pre-selected points. 

Opens the Survey Settings dialog box. 

Tools – Hardware Manager Menu 

 

Probes... 

Probe Adapters 

Scale Bars… 

Hidden Point Bars… 

Trackers… 

Theodolites… 

Ports… 

Opens the Hardware Manager dialog box at the Probes tab. 

Opens the Hardware Manager dialog box at the Probe Adapters tab. 

Opens the Hardware Manager dialog box at the Scale Bars tab. 

Opens the Hardware Manager dialog box at the Point Bars tab. 

Opens the Hardware Manager dialog box at the Trackers tab. 

Opens the Hardware Manager dialog box at the Theodolites tab. 

Opens the Hardware Manager dialog box at the Ports tab. 

Window Menu 

 

Tile 

Tile Vertically 

Cascade 

Arrange Icons 

Close 

Close All 

Next 

 1 Geometric etc. 

Tiles the open windows horizontally. 

Tiles the open windows vertically. 

Cascades the open windows. 

Arranges window icons in the work area. 

Closes the active window. 

Closes all windows. 

Change focus to the next window 

A list of all open windows appears at the bottom.  A 
check indicates which window is active. 
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Help Menu 

 

Contents 

Register… 

About FARO 
Insight… 

About Customer 
Support 

Opens the FARO Insight Help file. 

Opens the Register FARO Insight dialog box. 

Displays information about FARO Insight. 

 

Displays information about FARO Customer Support. 

FARO Insight Toolbars 

Overview 
The toolbars provide access to the most frequently used functions and features of 
FARO Insight.  For example, the standard toolbar allows you to recalculate features, 
update the display, plot graphs, and open worksheets and windows. 

To access the function, window, or dialog associated with any tool on the toolbar, 
clicks the appropriate button.  The following is a brief description of each of the 
buttons on the toolbars.  These tools are also explained at length in later sections of 
this manual. 

Note: Toolbars can be dragged to any convenient location on the screen as well as 
docked on the left or right side or top or bottom of FARO Insight.  “Tool Tips” are 
also displayed when the mouse cursor is placed over toolbar icon. 

The Standard Toolbar 

 
Standard Toolbar 

 

Create New Job 
Button  

Creates a new job. 

 

Open an Existing Job 
Button 

Opens a job previously created in FARO Insight. 

 

Print Button Print selected data to a printer. 

 

Print Preview Button Opens a preview window displaying what will be 
printed. 
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Print Setup Button Opens a dialog to adjust printer settings. 

 

Copy to Clipboard 
Button 

Copies selected (highlighted) items to the clipboard. 

 

Paste from Clipboard 
Button 

Pastes items from the clipboard into FARO Insight. 

 

Graphics Window 
Button 

Open the Graphics View Window.  See "Graphics 
View" for more information.  (available in Visual) 

 

Geometric Entities 
Button 

Open the Geometric Entities worksheet.  See 
"Geometric Entities Worksheet" for more 
information. 

 

Scalar Entities Button Open the Scalar Entities worksheet.  See "Scalar 
Entities Worksheet" for more information. 

 

Results Window 
Button 

Opens the Results Window. 

 

Standard Report 
Button 

Opens the Standard Report dialog box. 

 

Custom Report 
Button 

Opens the Custom Report dialog box. 

 

Tracker Mode Button Activates the tracker measurement mode. 

 

Theodolite Mode 
Button 

Activates the theodolite measurement mode. 

 

Observations Button View observation(s) of selected geometric entity. 

 

Graph Button Plot a graph of a set of values such as residual errors.  
See "Graph Windows" for more information. 

 

Edit Functions Button Opens the Function Editor.  See “Intuitive Function 
Definition” for more information. 

 

Edit Properties Button Opens the Feature Properties Page.  See “Features 
Display Options” in "Graphics View Window" for 
more information.  (available in Visual) 

 

Sort Button Sort the records in the Geometric or Scalar Entities 
worksheets.  See "Sorting Rows" for more 
information. 
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Magnify Button Open a magnified window on a worksheet cell.  See 
"Magnify Windows" for more information. 

 

Clear Observations 
Button 

Clears observation(s) of selected geometric entity. 

 

Auto Advance Button Switches between automatic and manual advancing 
after measurements. 

 

About FARO Insight 
Button 

Gives the version FARO Insight. 

 

Connect Button Connects to the tracker.  See "Connecting to the 
Tracker" for more information. 

 

Disconnect Button Disconnects from the tracker.  This button is 
available only when logged in to the tracker.  See 
"Disconnecting  from the Tracker" for more 
information. 

The Tracker Toolbar 

 
Tracker Toolbar 

 

Home Button Resets the laser beam at the home location. 

 

Measure Level 
Button 

Measures gravity vector using the trackers level 
sensor. 

 

Toggle Sight Button Toggles the sight mode from front sight to back sight. 

 

Measure Button Measures selected geometric entity. 

 

Go To Reset Button Resets the laser beam at the programmed location. 

 

Watch Window 
Button 

Opens the watch window for the selected feature.  See 
"Other Windows" in "FARO Insight Worksheets" for 
more information. 

 

Automatic Backsight 
Button 

Enables / disables automatic backsight capability. 
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Check Closure 
Button 

Checks laser interferometer closure. 

 

Measurement Probes 
Settings 

Opens the Measurement Probe Settings Dialog. 

 

Control Pad Opens the Tracker Control Pad. 

 

Health Checks Initiates the Health Checks. 

 

Diagnostics Performs Tracker Diagnostics. 

 

Compensations Performs Tracker Compensations 

Feature Toolbar 

 
Feature Create Toolbar 

 
Select Feature Type 
Dropdown List 

Select Type of feature to be created. 

 
Actual/Nominal List Select data set feature will be created in (Actual, 

Nominal, or both) 

 
Proposed Name 
Field 

Edit the name of proposed feature. 

 
Quantity Spinner 
Control 

Select number of features to be created. 

 
Method List Select measurement method to be assigned to the 

proposed feature(s).  This field changes to allow the 
user to select the assigned instrument when creating 
new stations. 

 

Set Properties 
Button 

Edit feature properties. 

 

Create Feature 
Button 

Create feature(s) in worksheet. 

 

Function Toolbar 
Button 

Show/Hide the creator Function Toolbar. 
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Display Settings 

 
Display Settings Toolbar 

 

Select Frame Select Name of View Frame. 

 

Reference Condition 
Button 

Selects Reference Condition 

 

Current Condition 
Button 

Selects Current Condition. 

 

Custom Condition 
Button 

Opens Display Settings Dialog to select custom 
condition, temperature or scale. 

 
Scale Shows display scale. 

 

Rectangular 
Coordinate System 
Button 

Selects Rectangular Coordinate System. 

 

Cylindrical 
Coordinate System 
Button 

Selects Cylindrical Coordinate System. 

 

Spherical Coordinate 
System Button 

Selects Spherical Coordinate System. 

 

Synchronize 
Windows 

Synchronizes windows. 

Orientation Toolbar 

 
Orientation Toolbar 

 

Object Material 
Button 

Specify the material (for scaling purposes) associated 
with each Object.  See "Object Temperature and 
CTE" under “Scale, Objects, and 
Movement…Scaling” for more information. 
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Object Temperature 
Button 

Input the object temperature.  See "Object 
Temperature and CTE" for more information.  

 

Object Movement 
Button 

Declare and compensate for Part object movement.  
See "Movement and Relocation" for more 
information.  

 

Scale Constraints 
Button 

Selects scale bar constraints. 

 

Bundle Input Button Shows Bundle Input Window. 

 

Run Bundle Button Runs the Bundle calculation. 

 

3D Best Fit Frame 
Button 

Create a 3D Best-Fit PART frame. See "3D Best Fit" 
for more information. (available in VisualPro) 

 

Best-fit to Reference 
File Button 

Create a Best-Fit PART frame to a Reference file.  
See " Best-fit Frame to a Reference File" for more 
information. 

 

Best-fit Frame Button Create a Best-Fit PART frame.  See " Best-fit Frame" 
for more information. 

Target Acquisition 

 
Target Acquisition Toolbar 

 

Search Button Searches for target. 

 

Aim Button Aims laser at the selected geometric entity. 

 

Set Distance Button Sets the distance along the laser beam path. 

 

Drive Visually Allows the Tracker to be aimed at a location using the 
mouse and arrow keys. 

 

Drive Manually Allows the Tracker to be aimed at a location by 
manually turning the Trackers aperture. 
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Drive Angles Allows the Tracker to be aimed to specific Azimuth 
and Zenith angles. 

The Search Toolbar 

 
Search Toolbar 

 

Search Up Button Searches upward in the Geometric Entities Worksheet 
to match the character string entered into the field 
with a feature name. 

 

Search Down Button Searches downward in the Geometric Entities 
Worksheet to match the character string entered into 
the field with a feature name. 

The Sensor Toolbar 

 
Sensor Toolbar 

 

Air Set Button Establishes air sensor set points. 

 

Material Set Button Establishes material sensor set points. 

 

Sensor Properties 
Button 

Establishes remote temperature sensor properties. 

The Survey Toolbar (ADM Tracker only) 

 
The Survey Toolbar 

 

Toolbuilder Button Use ADM to build a pre-selected set of points into 
position. 
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Periodic Inspection 
Button 

Use ADM for periodic inspection of pre-selected 
points. 

 

Drift Monitor Button Use ADM to monitor drift of pre-selected points. 

 

Survey Settings 
Button 

Define settings for automated survey. 

 

Pause Survey Button Pause the automated survey. 

 

Terminate Survey 
Button 

End the automated survey. 

Function toolbars 

Circle 

 
Circle Function Toolbar 

 

Reference Circle 
Button 

Create a circle from another circle or cylinder. 

 

Constructed Circle 
Button 

Create a circle from a Point, Vector and calculated 
distance. 

 

Circle from Features 
Button 

Creates a circle from a list of specific features. 

Cone 

 
Cone Function Toolbar 

 

Reference Cone 
Button 

Create a cone from another cone. 

 

Constructed Cone 
Button 

Create a cone from a Vector, Angle, Small Radius and 
Large Radius. 
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Cylinder 

 
Cylinder Function Toolbar 

 

Reference Cylinder 
Button 

Create a cylinder from another cylinder or circle. 

 

Cylinder from 
Features Button 

Creates a cylinder from a list of specific features. 

Ellipsoid 

 
Ellipsoid Function Toolbar 

 

Reference Ellipsoid 
Button 

Create an ellipsoid from another ellipsoid. 

 

Constructed Ellipsoid 
Button 

Creates an ellipsoid from a Vector, Major Axis and a 
Minor Axis. 

Frame 

 
Frame Function Toolbar 

 

Reference Frame 
Button 

Create a frame from another frame. 

 

Frame OPP Button Create a frame using the Origin, Point, Point function. 

 

Frame OPV Button Create a frame using the Origin, Point, Vector 
function. 

 

Frame OVP Button Create a frame using the Origin, Vector, Point 
function. 
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Frame OVV Button Create a frame using the Origin, Vector, and Vector 
function. 

 

Frame PLP Button Create a frame using the Plane, Line, Point function. 

 

Frame 321 Button Create a frame using the 3-2-1 Points function. 

Hyperboloid 

 
Hyperboloid Function Toolbar 

 

Reference 
Hyperboloid Button 

Create a hyperboloid from another hyperboloid. 

 

Constructed 
Hyperboloid Button 

Creates a hyperboloid from a Vector, Transverse Axis 
and a Conjugate Axis. 

Line 

 
Line Function Toolbar 

 

Reference Line 
Button 

Create a line from another features vector. 

 

Line from Two Points 
Button 

Create a line using two points. 

 

Line between Two 
Lines Button 

Create a line between two other features vectors. 

 

Line from Point and 
Vector Button 

Create a line from a Point and a Vector. 

 

Intersect Plane-Plane 
Button 

Create a line from the intersection of two planes. 
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Line from Features 
Button 

Creates a line from a list of specific features. 

Nurbs Surface 

 

Nurbs Surface Function Toolbar 

 

Reference Nurbs 
Surface Button 

Create a Nurbs Surface from another Nurbs Surface. 

Paraboloid 

 
Paraboloid Function Toolbar 

 

Reference Paraboloid 
Button 

Create a paraboloid from another paraboloid. 

 

Constructed 
Paraboloid Button 

Create a paraboloid from a Vector, and two measured 
distances.  The first as the Focal length, the second as 
the Eccentricity. 

Patch 

 

Patch Function Toolbar 

 

Reference Patch 
Button 

Create a patch from another patch. 

Plane 

 

Plane Function Toolbar 
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Reference Plane 
Button 

Create a plane from a Plane, Line, Plane or Circle. 

 

Plane from Three 
Points Button 

Create a plane from three points. 

 

Plane between Two 
Planes Button 

Create a plane between two other planes. 

 

Plane from Point and 
Vector Button 

Create a plane by defining its centroid and its normal 
vector. 

 

Plane from Features 
Button 

Creates a plane from a list of specific features. 

Point 

 
Point Function Toolbar 

 

Reference Point 
Button 

Create a point from another feature. 

 

Intersect Point-Line 
Button 

Create a point by intersecting a vector and a point. 

 

Intersect Point-
Paraboloid Button 

Create a point by intersecting a paraboloid and a 
point. 

 

Intersect Point-Patch 
Button 

Create a point by intersecting a point and a patch. 

 

Intersect Point-
Sphere Button 

Create a point by intersecting a point and sphere. 

 

Intersect Point-Plane 
Button 

Create a point by intersecting a point and a plane. 

 

Intersect Line-Line 
Button 

Create a point by intersecting two lines. 

 

Intersect Line-Plane 
Button 

Create a point by intersecting a line and a plane. 

 

Intersect Line-Patch 
Button 

Create a point by intersecting a line and a patch. 
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Intersect Point-Point 
Button 

Create a point by intersecting two points. 

 

Intersect Line-
Cylinder Button 

Create a point by intersecting a line and a cylinder. 

 

Hidden Point by 
Reference Button 

Create a point on a Hidden Point Bar by defining two 
points and defining a calculated distance. 

 

Hidden Point by Value 
Button 

Create a point on a Hidden Point Bar by defining two 
points and entering a distance. 

 

Hidden Point Button  Creates a point from a hidden point bar function based 
on a specified bar. 

 

Intersect Point-
Surface Button  

Creates a point by intersecting a point and a surface. 

Point Cloud 

 
Point Cloud Function Toolbar 

 

Intersect Point Cloud-
Plane Button 

Create a point cloud by Intersecting a point cloud to a 
plane. 

 

Point Cloud from 
Features Button 

Creates a point cloud from a list of specific features. 

Sphere 

 
Sphere Function Toolbar 

 

Reference Sphere 
Button 

Create a sphere from another sphere. 

 

Sphere from Features 
Button 

Creates a sphere from a list of specific features. 
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Surface Deviation (available in VisualPro) 

 

Surface Deviation Function Toolbar 

 

3D Calculate 
Deviation Button 

Create a surface deviation between a point cloud and a 
surface. 

CAD Generated Surfaces (Tabulated, Revolution, Ruled and 
Spline Surface) 

 

Surface Function Toolbar 

 

Reference Surface 
Button 

Create a CAD generated surface from another CAD 
generated surface. 

Graphics View Toolbar (available in Visual) 

 
Graphics View Toolbar 

 
Select Feature Type 
Dropdown List 

Select Type of feature to be displayed in the Graphics 
View. 

 
Actual/Nominal List Select data set that will be displayed (Actual, 

Nominal, or All). 

 

Zoom In Zoom in on the Graphics View by a factor of 2. 

 

Zoom Out Zoom out on the Graphics View by a factor of 2. 

 

Zoom Box Manually select an area in the Graphics View to zoom 
in on. 

 

Zoom All Adjusts the Graphics View so that all features are 
displayed. 
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Top View Adjust the Graphics View so that you are looking 
down the +Z axis. 

 

Bottom View Adjust the Graphics View so that you are looking 
down the -Z axis. 

 

Front View Adjust the Graphics View so that you are looking 
down the +X axis. 

 

Back View Adjust the Graphics View so that you are looking 
down the -X axis. 

 

Left View Adjust the Graphics View so that you are looking 
down the -Y axis. 

 

Right View Adjust the Graphics View so that you are looking 
down the +Y axis. 

 

Isometric View Adjust the Graphics View so that all positive axes are 
towards you. 

 

Magnify Deviations Increase the scale of the deviations. 

 

Demagnify Deviations Decrease the scale of the deviations. 

 

Toggle Surface 
Shading 

Display the shading of a surface. 

Graphics Settings Toolbar (available in Visual) 

 
Graphics Settings Toolbar 

 

World Center 
Rotation 

Set the mouse control in the Graphics View to 
rotate about the center of the display. 

 

Active Feature 
Center Rotation 

Set the mouse control in the Graphics View to 
rotate about the active feature. 

 

Deviation Spikes Set the display of deviations in the Graphics View 
to Spikes. 
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Deviation Connected 
Points 

Set the display of deviations in the Graphics View 
to Connected Points. 

 

Deviation Spikes & 
Connected Points 

Set the display of deviations in the Graphics View 
to Spikes and Connected Points. 

 

Increase 
Smoothness 

Increase the display smoothness of features in the 
Graphics View. 

 

Decrease 
Smoothness 

Decrease the display smoothness of features in the 
Graphics View. 

 

Modify by Polygon 
Select 

Modify observations or a Point Cloud in the 
Graphics View using Polygon Select. 

Graphics Active Feature Toolbar (available in 
Visual) 

 
Graphics Active Feature Toolbar 

 

Show Deviations Display the deviations of a calculated feature and its 
nominal or observations. 

 

Show Deviation 
Statistics 

Display the statistics between features and its 
nominal or observations. 

 

Show Observations Display the observations of a measured feature. 

 

Show Normal Display the direction of a features normal vector. 

 

Flip Normal Assigns the Flip Normal function to the active 
surface. 

The Status Bar 

Overview 

 
Status Bar 
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The status bar displays messages and information that helps you while using FARO 
Insight.  It can be broken up into three sections, Help Messages, Operational 
Messages, and Options.  The Help Messages section will display a description of 
whatever menu item you have highlighted or toolbar button you have the mouse 
pointer over.  It displays “Ready” when there is no help text to be displayed. 

The Operational Messages section will display a description of whatever action 
FARO Insight is performing or has just completed.  You can see if FARO Insight is 
recalculating, if any errors were encountered during the calculation, or the name of 
the feature you have just activated. 

The Options section will display any additional information that you choose to show.  
Here, you can display the sight mode, the units of length, angle or temperature you 
are working in, whether auto-recalculation is on or off, the relocation position, or 
other options.  You can also show the laser status, which indicates whether the laser 
beam has been broken. 

Customizing the Status Bar 
The Options section of the Status Bar can be customized in the following manner: 

1. From the Settings menu, choose Status Bar (Alt, S, S). 

FARO Insight displays the Status Bar Options dialog. 

 
Status Bar Options Dialog 

2. To add an option, click in its box.  A check mark will appear.  To 
remove an option, click once more in its box.  The check mark will 
disappear. 

3. When you have selected the desired options, press the ‘Apply’ button. 

4. When finished, click the ‘OK’ button. 

The Work Area 
The remainder of the FARO Insight program window, between the toolbars and the 
Status Bar, comprises the Work Area.  The Work Area displays the worksheets, 
views, windows, and dialogs through which FARO Insight accepts user input.  When 
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the user opens the Gents and the Sents worksheets, they are displayed in the work 
area.  Likewise, watch windows, magnified cells, and graph plots are all windows 
that FARO Insight displays in its work area. 

 
Observation window tiled with the Gents sheet in the work area 

The commands in the Window menu allow you to control the layout and 
arrangement of the work area.  You can open, close, tile, cascade, minimize, and 
maximize windows and worksheets in order to arrange the work are in the most 
effective format for the current job. 

Tiling and cascading windows 
Tiling refers to the placement of a group of windows so they lie next to one another.  
This arrangement is convenient when you want to open a number of watch windows 
in order to build a tool.  When tiling, you have the option of tiling either vertically, 
or horizontally.  Tiled windows tend to be small since they share the screen with 
other windows. 

Cascading refers to an arrangement whereby the windows are overlapped so that 
only one is completely visible, but it occupies more of the screen than if the same 
number of windows were tiled. 

You can tile or cascade a series of windows in the following manner: 

1. Open whichever windows you want to arrange.  Do not minimize them, 
however; minimized windows are not automatically restored when the 
work area is tiled or cascaded. 

2. From the Window menu, choose Tile (Alt, W, T) to tile the windows 
horizontally.  Choose Tile Vertically (Alt, W, V) to tile the windows 
vertically.  Choose Cascade (Alt, W, C) to cascade the windows. 

Closing, minimizing and restoring windows 
You can close, minimize and restore windows as required to arrange the necessary 
information on the screen. 

• To minimize a window, click its control menu in the upper left-hand 
corner, and select Minimize. 
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• To restore a minimized window, click on it once and select Restore, or 
double-click on it. 

• To close the active window, go to the Window menu item, choose 
Close (Alt, W, L), or double-click in its control menu. 

• To close all windows in the work area, go to the Window menu, choose 
Close All (Alt, W, A). 

Moving and resizing windows 
You can move and resize windows to get the most effective use of the screen. 

• To resize a window, grab one of its borders with the mouse pointer, 
hold down the left mouse button, and drag to the desired size.  Grab the 
corner of the window to resize it both vertically and horizontally. 

• To move a window, hold the mouse pointer over its title bar, hold down 
the left mouse button and drag it to its new position. 

Viewing Data 
FARO Insight allows you to view your data in many different ways at any time in a 
job.  This section describes ways of adjusting viewing conditions such as changing 
units, setting the frame or, coordinate system, in which you see your data, and 
controlling calculation.  Setting these controls correctly will ensure that you view 
meaningful results. 

Units and Display Resolution 
FARO Insight stores all data internally in S.I. units: meters, radians,  C, and mmHG.  
You can, however, display data in many units of measure such as inches, decimal 
degrees,  F, and inHg.  You can also select the total number of display digits and the 
number of places after the decimal. 

There is no loss in accuracy when switching between units.  However, you should be 
careful to maintain an appropriate resolution when importing and exporting in ASCII 
format. 

Changing units and resolution 
FARO Insight automatically selects the number of places after the decimal when you 
change units.  You can override this setting if you want more or less resolution. 

1. From the Settings menu, choose Units (Alt, S, U). 

FARO Insight displays the Numerical Format dialog. 
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Numerical Format Dialog 

2. For each of the measured values – Length, Angle, Time, Temperature, 
and Pressure – select the desired units from the drop down box. 

3. Under Precision, select the number of places after the decimal for each 
type of measure. 

4. Under Width, select the total number of display digits for each type of 
measure. 

5. Press the ‘OK’ button.  FARO Insight will update the display. 

Condition and Display Frame 
The Condition and Display Frame controls how feature values, such as position and 
orientation, are resolved when displayed in a worksheet.  Condition refers to the 
scale of the feature; Current condition is the actual scale of the feature as it currently 
exists; Reference condition is the scale of the feature at reference temperature (20 C). 

The Display Frame controls the coordinate reference frame or station in which the 
features are resolved.  You can select the display frame to be any frame or station 
that has been defined.  You can always select the station @STATION01 or PART 
frame because they exist by default.  You must define any other frame or station 
before attempting to select it as the view frame. 

When you import data, it is necessary to set the condition and display frame to match 
the condition and frame of the data you are importing; otherwise FARO Insight will 
incorrectly convert the data as it is imported.  See “Scale, Objects, and Movement” 
for more information. 

Setting the condition and display frame 
The condition and display frame can quickly be selected using the Display Settings 
toolbar.  Any frame or station can be selected from the toolbar’s Select Frame list.  
The condition can be quickly changed from Current to Reference using the Current 
and Reference Condition buttons on the toolbar.  Other conditions must be selected 
using the Custom button to open the Display Settings dialog.   

To use the Display Settings dialog to set the condition and display frame, do the 
following: 
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1. From the View Menu, choose Display Settings (Alt, V, D) or click on 
the Custom button, , on the Display Settings toolbar. 

FARO Insight displays the Display Settings dialog. 

 
Display Settings Dialog 

2. To change the Display Frame, select the desired frame. 

3. To change the Condition, do one of the following 

• To display all objects at Reference condition (20 C, or 68 F), 
choose Reference Temperature. 

• To display all objects at a particular temperature, select degC 
(degF if you are working in Fahrenheit) and enter the desired 
temperature.  Note: You must also specify the object material.  
Refer to "Scale, Objects, and Movement” for more information. 

• To display all objects at a particular scale, choose A Scale of and 
enter the desired scale. 

• To display each object at its current condition, or current scale, 
choose Current Condition. 

4. Press ‘OK’ when you are done. 

Note:  The Coordinate System options are available when the Display Settings 
dialog is accesses while importing data, using a Watch Window or viewing a Results 
window. 

Controlling Calculation 
FARO Insight automatically handles the calculations that are performed on features, 
such as fitting observations to a geometric shape.  There are two different ways 
FARO Insight can handle the recalculation of features that are dependent upon 
others: with or without the use of the automatic recalculation feature.  Although the 
end result of each calculation is exactly the same, you may choose not to use the auto 
recalculation feature to save time. 
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Automatic Recalculation 
When you measure a feature, FARO Insight automatically calculates the feature fit 
and updates the display for that feature.  For example, when you measure a point, 
FARO Insight calculates the centroid of the set of observations and displays the 
calculated X, Y, and Z values in the Gents worksheet.  Anytime you subsequently 
modify its observations, or apply a function to it; FARO Insight will automatically 
recalculate the point. 

If the auto recalculation feature is activated, recalculation is hierarchical and 
accomplished immediately following any change in the worksheet.  FARO Insight 
uses a dependency tree to recalculate the worksheet starting with the changed feature 
affected, in hierarchical order, all features dependent upon the changed feature.  
When auto recalculation is activated, you do not need to recalculate the worksheet 
after any change. 

For example, consider the following situation.  You measure three tooling balls as 
spheres, declare three points that reference the centers of the spheres, and use the 
three points to define a best-fit frame.  You then decide to constrain the spheres to a 
fixed radius.  To properly calculate the frame, FARO Insight will automatically 
recalculate the spheres, then the points that are dependent on the spheres, and finally 
the best-fit frame. 

Manual Recalculation 
Auto recalculation, when activated, will react to any change in the Gents or Sents 
worksheets.  The resulting calculations could be time consuming if the changing 
feature affects many other features.  In order to save time, you may want to 
deactivate the auto recalculation feature and initiate recalculations manually. 

To deactivate auto recalculation, from the Settings menu, choose Auto Recalculation 
(Alt, S, A).  If a check appears next to Auto Recalculation, the feature is active.  
When deactivated, the check will not be visible. 

If auto recalculation is deactivated and a change is made to a feature, that feature will 
still automatically recalculate with each change, but dependent features will not 
change.  When you want to enact the resulting changes on the dependent features, 
from the Edit menu, choose Recalculate (Alt, E, R) or press the F5 key.  If numerous 
changes have been made without a recalculation, all necessary recalculations will be 
made when the recalculation is initiated. 
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Hardware Manager 

Hardware Manager Basics 
The Hardware Manager is a group of dialogs that organize and maintain specified 
hardware for use within a FARO Insight job.  This dialog can be accessed from the 
Tools Menu and then by selecting a particular type of hardware.  The dialog arranges 
each type of hardware into its own location where they can be added, deleted, or 
modified. 

 The types of hardware found in this interface are Probes, Probe Adapters, Scale 
Bars, Hidden Point Bars, Trackers, and Theodolites.  Some jobs may require the use 
of only a few items, or it is possible to need to use many of the same type of 
hardware within a particular job. 

The Hardware Manager dialog lists all of the items within a particular category in the 
window portion of the dialog.  The name of the item, along with some key 
information is listed here, so the user can easily locate which piece of hardware they 
are looking for.  All of the information within the Hardware Manager is stored in a 
file called Hardware.ini, which is located within the main FARO Insight directory. 

 
Hardware Manager Dialog (Tracker Tab Open) 

Probes 
The Probes tab in the Hardware Manager dialog maintains the measurement probes 
that can be used within FARO Insight.  It will contain a list of default probes.  The 
dialog will list all of the probes available, along with their diameters given in the 
currently set units. 
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Probes Tab of Hardware Manager Dialog 

Probe Adapters 
The Probe Adapters tab in the Hardware Manager dialog maintains the probe 
adapters that can be used within FARO Insight.  It will contain a list of default probe 
adapters.  The dialog will list all of the adapters available, along with their diameters 
given in the currently set units. 

 
Probe Adapters Tab of Hardware Manager Dialog 

Scale Bars 
The Scale Bars tab in the Hardware Manager dialog maintains the bars of known 
length that can be used within FARO Insight for theodolite measurements.  (For use 
within a Scale Constraint.)  Initially, there will be no bars within this portion of the 
Hardware Manager.  The dialog will list all of the bars available, along with their 
Serial Number, Length, Standard Deviation, Material, and CTE.  (All items are 
displayed in the currently set units.) 
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Scale Bars Tab of Hardware Manager Dialog 

Adding a New Scale Bar 
New scale bars will need to be added initially to FARO Insight.  Others can be 
entered later when needed.  Each bar will need an exclusive name and associated 
values for its properties. 

1. From the Scale Bars Tab of the Hardware Manager (Alt, L, H, S), 
choose Add (Alt A). 

FARO Insight displays the Add Scale Bar dialog. 

 
Add Scale Bar Dialog 

2. Enter a name for the bar that is to be added. 

3. Enter the serial number of the scale bar. 

4. Enter the known length of the scale bar. 

5. Enter the known Standard Deviation of the scale bar. 

6. Choose the Material of the scale bar.  (The CTE will be displayed 
automatically, based on given materials.) 

7. Press the ‘OK’ button. 

FARO Insight will then add the bar to the list of Scale Bars that are 
available to be used in a job. 
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Editing a Scale Bar 
There is a chance that the user may want to edit the name or other properties of an 
already existing bar, without having to delete the existing one and re-create it.  Doing 
so will update the Hardware Manager and any references to it within the active job 
file. 

1. Open the Scale Bars Tab of the Hardware Manager (Alt, L, H, S). 

2. Select the scale bar from the list that is to be updated and choose Edit 
(Alt E). 

FARO Insight displays the Edit Scale Bar dialog. 

 
Edit Scale Bar Dialog 

3. Change the desired properties for the scale bar to their new values. 

4. Press the OK button. 

FARO Insight will then update the existing scale bar specifications to 
the new ones just entered. 

Deleting a Scale Bar 
Scale bars may get replaced or never used, so the user may want to remove these 
from the list of bars to keep a more concise list of those that would be used.  By 
using the delete option, the user can remove any of the existing bars from the 
Hardware Manager. 

1. Open the Scale Bars Tab of the Hardware Manager (Alt, L, H, S). 

2. Select the Scale Bar from the list that is to be removed and choose 
Delete (Alt D).   

3. FARO Insight will remove the bar from the list of available scale bars. 

Hidden Point Bars 
 

The Hidden Point Bars tab in the Hardware Manager dialog maintains the hidden 
point bars of known length that can be used within FARO Insight.  Initially, there 
will be no bars within this portion of the Hardware Manager.  The dialog will list all 
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of the bars available, along with their Serial Number and Length (displayed in the 
currently set units). 

 
Hidden Point Bars Tab of Hardware Manager Dialog 

Adding a New Hidden Point Bar 
New hidden point bars will need to be added initially to FARO Insight.  Others can 
be entered later when needed.  Each bar will need an exclusive name with an 
associated serial number and length. 

1. From the Hidden Point Bars Tab of the Hardware Manager (Alt, L, H, 
H), choose Add (Alt A). 

FARO Insight displays the Add Hidden Point Bar dialog. 

 
Add Hidden Point Bar Dialog 

2. Enter a name for the bar that is to be added. 

3. Enter the serial number of the hidden point bar. 

4. Enter the known length of the hidden point bar. 

5. Press the OK button. 

FARO Insight will then add the bar to the list of Hidden Point Bars that 
are available to be used in a job. 

Editing a Hidden Point Bar 
There is a chance that the user may want to edit the name or other properties of an 
already existing bar, without having to delete the existing one and re-create it.  Doing 
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so will update the Hardware Manager and any references to it within the active job 
file. 

1. Open the Hidden Point Bars Tab of the Hardware Manager (Alt, L, H, 
H). 

2. Select the hidden point bar from the list that is to be updated and 
choose Edit (Alt E). 

FARO Insight displays the Edit Hidden Point Bar dialog. 

 

3. Change the desired properties for the hidden point bar to their new 
values. 

4. Press the OK button. 

FARO Insight will then update the existing hidden point bar 
specifications to the new ones just entered. 

Deleting a Hidden Point Bar 
Hidden Point bars may get replaced or never used, so the user may want to remove 
these from the list of bars to keep a more concise list of those that would be used.  
By using the delete option, the user can remove any of the existing bars from the 
Hardware Manager. 

1. Open the Hidden Point Bars Tab of the Hardware Manager (Alt, L, H, 
H). 

2. Select the Hidden Point Bar from the list that is to be removed and 
choose Delete (Alt D).   

3. FARO Insight will remove the bar from the list of available hidden 
point bars. 

Trackers 
The Trackers tab in the Hardware Manager dialog maintains the trackers that can be 
used within FARO Insight.  The dialog will list all of the trackers available, along 
with their Serial Number and Model type. 
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Trackers Tab of Hardware Manager Dialog 

Adding a New Tracker 
New trackers will need to be initially added to FARO Insight.  Others can be entered 
later when needed.  Each tracker will need the model type, a name, the IP Address 
and uncertainties, which affect the results of the Bundle. 

1. From the Trackers Tab of the Hardware Manager (Alt, L, H, T), choose 
Add (Alt A). 

FARO Insight displays the Add Tracker dialog. 

 
Add Tracker Dialog 

2. Select a specific type of tracker. 

3. Enter a name for the tracker that is to be added.  The name is usally 
TcXXXX where XXXX is the tracker’s serial number. 

4. FARO Insight will automatically enter an IP address based on the 
tracker serial number. 
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5. Enter the uncertainties for the tracker and environment.  The default 
uncertainties are derived from the trackers specifications combined 
with environmental effects found in the average users environment.  If 
the environment the tracker is going to be used in has a great deal of 
vibration or air movement, these uncertainty values may need to be 
increased. 

6. Press the ‘OK’ button. 

FARO Insight will then add the tracker to the list of trackers that are 
available to be used in FARO Insight. 

Editing a Tracker 
There is a chance that the user may want to edit the name or other properties of an 
already existing tracker, without having to delete the existing one and re-create it.  
Doing so will update the Hardware Manager but not any references to it within the 
job files. 

Note:  A tracker’s properties are stored within the station when they are initially 
selected for that station.  Any changes made to the properties of a tracker from the 
Hardware Manager will not be reflected until it is used in a new station or a new job. 

1. Open the Trackers Tab of the Hardware Manager (Alt, L, H, T). 

2. Select the tracker from the list that is to be updated and choose Edit 
(Alt E). 

FARO Insight displays the Edit Tracker dialog. 

 
Edit Tracker Dialog 

3. Change the desired properties for the tracker to their new values.  (The 
type can not be modified.) 

4. Press the ‘OK’ button. 

FARO Insight will then update the existing tracker specifications 
within the Hardware Manager to the new ones just entered. 
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Deleting a Tracker 
A tracker may get replaced, so the user may want to remove one from the list of to 
keep a more concise list of those that would be used.  By using the delete option, the 
user can remove any of the existing trackers from the Hardware Manager. 

1. Open the Trackers Tab of the Hardware Manager (Alt, L, H, T). 

2. Select the tracker from the list that is to be removed and choose Delete 
(Alt D).   

3. FARO Insight will remove the tracker from the list of available 
Trackers within the Hardware Manager. 

Theodolites 
The Theodolites tab in the Hardware Manager dialog maintains the theodolites that 
can be used within FARO Insight.  Initially, there will be no theodolites within this 
portion of the Hardware Manager.  The dialog will list all of the theodolites 
available, along with their Serial Number, Model type, and Unit Address.  (The Unit 
Address will be 0 when it is not required.) 

 
Theodolites Tab of Hardware Manager Dialog 

Adding a New Theodolite 
New theodolites will need to be added initially to FARO Insight.  Others can be 
entered later when needed.  Each theodolite will need an exclusive name with an 
associated serial number, a model type, unit address (if required), and uncertainties 
(which use the currently set units). 

1. From the Theodolites Tab of the Hardware Manager (Alt, L, H, D), 
choose Add (Alt A). 

FARO Insight displays the Add Theodolite dialog. 
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2. Select a specific type of theodolite. 

3. Enter a name for the theodolite that is to be added. 

4. Enter the serial number of the theodolite. 

5. Enter the unit address of the theodolite, if needed. 

6. Check the ASB Button Attached option if the theodolite is going to use 
an ASB button to record the measurements. 

7. Enter the known uncertainties of the theodolite. 

8. Press the ‘OK’ button. 

FARO Insight will then add the theodolite to the list of theodolites that 
are available to be used in FARO Insight. 

Editing a Theodolite 
There is a chance that the user may want to edit the name or other properties of an 
already existing theodolite, without having to delete the existing one and re-create it.  
Doing so will update the Hardware Manager but not any references to it within the 
job files. 

Note:  Theodolite properties are stored within the stations when they are initially 
selected for that station, therefore any changes made to the theodolites within the 
Hardware Manager will not be reflected. 

1. Open the Theodolites Tab of the Hardware Manager (Alt, L, H, D). 

2. Select the theodolite from the list that is to be updated and choose Edit 
(Alt E). 

FARO Insight displays the Edit Theodolite dialog. 
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Edit Theodolite Dialog 

3. Change the desired properties for the Theodolite to their new values.  
(The type can not be modified.) 

4. Press the ‘OK’ button. 

FARO Insight will then update the existing theodolite specifications 
within the Hardware Manager to the new ones just entered. 

Deleting a Theodolite 
A theodolites may get replaced, so the user may want to remove one from the list of 
to keep a more concise list of those that would be used.  By using the delete option, 
the user can remove any of the existing theodolites from the Hardware Manager. 

1. Open the Theodolites Tab of the Hardware Manager (Alt, L, H, D). 

2. Select the theodolite from the list that is to be removed and choose 
Delete (Alt D).   

3. FARO Insight will remove the theodolite from the list of available 
Theodolites within the Hardware Manager. 
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FARO Insight Worksheets 

Worksheet Basics 

What are worksheets? 
Worksheets are spreadsheet-like windows that display a certain class of data.  They 
arrange data such as feature names, feature locations, and feature orientation in a 
layout that is easy to work with.  Virtually all of the information you enter into, and 
get out of, the program is done through a worksheet interface. 

FARO Insight uses three types of worksheets: Geometric Entities, Scalar Entities, 
and Observations.  Geometric entities are features such as points, lines and frames - 
they are multi-dimensional objects.  Scalar entities are single dimensional features 
such as angles and distances - objects that are completely described by a scalar value.  
Observations are the fundamental measurements of position (x, y, z) that are stored 
when a geometric entity is measured.  They are displayed in their own worksheets in 
order to make viewing data more manageable. 

 
The Geometric Entities Worksheet 

These three worksheets are the primary interface to FARO Insight.  Whenever you 
want to measure a feature such as a point, sphere or plane, to create a coordinate 
reference frame, to compute the angle between two lines, or to compare 
measurements to a nominal data set, you will do it through a worksheet. 

Navigating in a Worksheet 
Worksheets are virtual windows into the job database; since it is usually not possible 
to view the entire contents of a job at once, FARO Insight virtualizes the display and 
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allows you to view select portions at one time, either by scrolling the display or by 
hiding feature attributes. 

Cell focus 
In each spreadsheet, one cell will have the focus, indicated by a double line border.  
Having the focus means that input from the keyboard, mouse, or tracker is directed 
toward that cell.  For example, to edit the name of a point, you must set focus on (by 
clicking with the mouse or using the arrow keys) the name cell. 

 

When you have multiple worksheets open simultaneously, each sheet will have at 
least one cell with a double line border, but only one (or possibly none) will be 
active.  For example, you may have three observation windows open, but the active 
window is the Gents worksheet.  Focus will be on the Gents worksheet. 

Another situation occurs when you set focus on a cell, then use one of the display 
filters such as the drop-down list that control feature type.  Even though one cell has 
a double line border, the input focus is still on the list box and any keyboard input is 
directed to the list. 

Note:  At times, a cell in the active window may have the focus, but will refuse to 
accept input.  To overcome this, move off the cell and then back on using either the 
mouse or the arrow keys. 

Moving around a worksheet 
It is usually necessary to scroll up/down and left/right in order to view the entire 
contents of a worksheet. 

• To scroll the worksheet horizontally, click the left or right arrows,  
or , at the ends of the scroll bar.  If a scroll bar does not appear, the 
worksheet is too small to be scrolled in that direction. 

You can also scroll by dragging the thumb button in the scroll bar.  To 
scroll one screen at a time, click on the scroll bar between the arrow 
and the thumb button. 

• To scroll the worksheet vertically line by line, click the upper or lower 
inner arrows,  or , at the ends of the vertical scroll bar. 

You can also scroll vertically one screen at a time by clicking the upper 
or lower middle arrows,  or , at the ends of the vertical scroll bar. 

To go directly to the top or to the bottom of the worksheet, click the 
upper or lower outer arrows,  or , at the ends of the vertical scroll 
bar. 
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Selecting cells 
Sometimes it is necessary to select a range of cells for a number of operations, such 
as reporting, copying the contents of one cell to another, selecting points for a best-
fit frame, etc. 

• With the mouse, hold down the left button while dragging over the cells 
that you want to select. 

• Using the keyboard, hold down the SHIFT key and use the arrow keys 
to mark the cells you want to select. 

• You can select multiple ranges of cells by holding down the CTRL key 
while selecting subsequent ranges of cells. 

Editing, copying, and deleting cells 
FARO Insight allows you to edit, copy and delete cells after they have been created.  
This is useful when you want to rename a feature that has already been created, if 
you want to make it similar to another feature, or if you don’t need a feature 
anymore. 

Editing the contents of a cell 
The means of editing vary from column to column; the most common way is to set 
focus on the cell and, from the Edit menu, choose Cell (Alt, E, L), press the F2 key, 
or double-click directly in the cell.  Some cells are for status or results and can only 
be viewed, not edited. 

Copying cell contents 
To save time, you can copy the contents of one cell and paste is in a range of other 
cells.  This expedites assigning methods, offsets and even functions. 

1. Select the cell whose contents you want to copy. 

2. From the Edit menu, choose Copy (Alt, E, C) or press CTRL+C. 

3. Select the cells into which you want to paste the cell contents. 

4. From the Edit menu, choose Paste (Alt, E, P) or press CTRL+V. 

If Auto Recalculation isn’t on, it may be necessary to update the display 
before the pasted information is displayed. 

Deleting a feature 
When you delete a feature, it is removed from the job database.  See to “Clearing 
and Deleting Observations” for information on how to re-measure a feature without 
deleting it. 

1. Set focus on the feature you want to delete. 

2. From the Edit menu choose Delete (Alt, E, D), or press DELETE.  
FARO Insight prompts you to verify the deletion. 

Searching the Gents Sheet 
The Search toolbar allows the user to search the Gents sheet for a particular feature 
name.  This toolbar becomes available for use any time the Gents sheet is the active 
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window.  When used, FARO Insight will highlight the first cell in the name column 
that matches the search requirements. 

 
Search Toolbar 

The operator simply types in the name of a feature in the field, and presses either the 
up or down arrow to search either up or down in the Gents sheet for any matching 
feature name.  The search is not case sensitive, and will stop on any feature in which 
the first characters of the feature’s name match the search entry.  For example, if the 
letters ‘Poin’ are entered into the search field and one of the search arrows are 
clicked, FARO Insight will highlight the first name cell that has the string ‘Poin’ as 
its first four characters.  Subsequent searches for ‘Poin’ will highlight the next cell 
with a matching feature name.  A feature name that possesses characters that precede 
the string ‘Poin’, such as ‘Datum_A_Point’, will be passed up by the search.  To find 
a featured named ‘Datum_A_Point’, the user should use a string like ‘Datum’ as the 
search criteria. 

Rearranging Rows and Columns 
The columns in each of the FARO Insight worksheets can be rearranged by adding, 
deleting, and moving columns in order to display more or less information, or to 
display data in a format that is most appropriate for a given task.  For example, it is 
necessary to display the focal length and eccentricity when you are working with 
paraboloids, but it is useless information otherwise.  Likewise, when you are 
working with lines and planes, it is convenient to rearrange the worksheet so that the 
features’ vectors are displayed in a prominent location. 

Sorting Rows 
By default, FARO Insight sorts the rows in the order that the features were created.  
New features are always put at the bottom of the list.  The default sort method may 
be overridden by specifying a custom sort order.  Once a custom sort order is 
specified, it will persist for the rest of the job, or until another custom sort order is 
specified. 

To set the sort order, do the following: 

1. From the Settings menu, choose Rows (Alt, S, R). 

FARO Insight displays the Sort dialog. 

 
Sort Dialog 

2. In the 1st Key dropdown box, select the primary key (worksheet 
column) according to which you want to sort, and the sort order – 
Ascending or Descending. 
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For example, to sort all records primarily by the ascending type (circle, 
sphere, etc) select Type from the sort list and click Ascending. 

3. To define a secondary sort order, select a second key and sort order in 
the 2nd Key dropdown. 

For example, if you sort primarily by Name, you can sort duplicate 
names according to Type. 

4. In the 3rd Key dropdown, select a tertiary key and order, if desired. 

5. To sort the worksheet right away, choose Sort now.  Choose OK when 
you are done. 

Clicking the Sort button, , on the Standard Toolbar will 
immediately arrange the worksheet to the current sort settings. 

Resizing columns 
You may want to resize the columns in a worksheet in order to accommodate for 
longer feature names, or to squeeze the greatest number of columns possible out of a 
limited screen size. 

• To resize the width of a single column, move the mouse pointer to the 
right edge of its heading (the mouse pointer becomes a double arrow).  
Drag the right boundary of the column to the desired width while 
holding down the left mouse button. 

• To resize multiple columns, select the columns (drag over their column 
headings with the mouse pointer while holding down the left mouse 
button, they must be adjacent) and then resize one of the columns as 
described previously.  The selected columns will be identical in width 
to the column you resized. 

Force FARO Insight to write the new column widths to the 
INSIGHT.INI file by moving the worksheet slightly. 

Adding, deleting, and moving columns 
When you rearrange columns in the Scalar, Geometric Entities, and Observations 
worksheets, the changes are stored in the INSIGHT.INI file. 

To add, delete or move columns, do the following: 

1. From the Settings menu, choose Columns (Alt, S, C) or double click 
anywhere on the column header of the worksheet. 

 

2. FARO Insight displays the Spreadsheet Column Setup dialog. 
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Spreadsheet Column Setup Dialog 

• To add a column, double-click on the column name in the Fields to 
Add list, or highlight the name and press the add button, . 

• To delete a column, double-click on the column name in the 
Spreadsheet Columns list, or highlight the name and press the 

delete button, . 

• To move a column left or right, click on that column in the 
Spreadsheet Columns list.  To move the column left, press the 
Move Up button, .  To move a column right, press the 

Move Down button, .  Do this as many times as 
necessary. 

• To prevent the name column from moving when you scroll the 
worksheet left and right, click on the Freeze Name Column check box. 

3. When you are done, press ‘OK.’ 

Note:  The user can move multiple column names at the same time when using the 
Spreadsheet Column Setup dialog box. 

Saving multiple column configurations 
There are a variety of applications that require different column layouts, especially in 
the Geometric Entities worksheet.  You can avoid having to manually rearrange the 
columns when you switch tasks by storing your favorite configurations in the 
INSIGHT.INI file.  You should feel comfortable editing system files before trying 
this operation. 

1. Arrange the columns for a particular configuration. 

2. Edit the INSIGHT.INI file (located in the directory FARO Insight is 
installed in) and look for the section marked [Layout]; it should be near 
the bottom of the file. 

3. Create a new section labeled [MyLayout] – you can substitute a more 
descriptive label – and then copy the line that begins “Geometric 
Entities Columns” (followed by a series of numbers) into the new 
section. 

4. Repeat Steps 1 through 3 for any other configurations you want to save.  
You can store each configuration in its own section. 
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5. When you want to change configurations, replace the “Geometric 
Entities Columns” from the [Layout] section with one of your own 
layouts.  You must restart FARO Insight for the change to be in effect. 

Geometric Entities Worksheet 

Geometric Entities 
Geometric Ent

The Geometric Entities worksheet is where most of the work can be done.  In this 
window, you will create, edit, measure, and view results of features such as points, 
circles, and spheres.  You can configure it in multiple ways to show only the 
information you need. 

ities - or Gents - are features such as points, lines, spheres, and frames.  
Entities that are defined by an X, Y, Z (depending on the coordinate system used) 
location and which may also have associated with them an I, J, K direction vector, 
and possibly a size/shape parameter such as radius or focal length.  Geometric 
entities may be contrasted with scalar entities, such as angles and distances: entities 
that are expressed by a single value. 

 
Geometric Entities Worksheet 

Opening the Geometric Entities worksheet 
The Gents worksheet appears as a spreadsheet within the FARO Insight work area.  
You can maximize or minimize it, tile or cascade it with other windows or 
worksheets in the work area.  It is possible to have multiple copies of the Gents 
worksheet open at a single time. 

• To open the Gents worksheet, from the View menu, choose Geometric 
Entities (Alt, V, E) or press the Gents button, , on the Standard 
Toolbar. 

• If the Gents window is minimized, you can restore it by double clicking 
on its control icon. 

Declaring Features 
Each geometric entity that you measure, or compute must first be declared in the 
Gents worksheet.  Declaring an object accomplishes two things: it creates a record in 
the database for that object, and it tells FARO Insight how the object is to be 
measured, input or calculated. 
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Every object in the Gents worksheet is defined in one of three ways: by 
measurement, by calculation based on other objects, or by manual entry.  For 
example, you measure the actual values of objects such as control points, you 
manually enter (by typing or importing) the nominal values of these same points, and 
you calculate the frame using a function that relates the measured actuals to the 
entered nominals. 

What is declaring a feature? 
You must declare an entity in FARO Insight before you can measure it, calculate it, 
print it, or even see it on the screen.  Declaring a feature is telling FARO Insight 
what the feature Type is, what data Set it is defined in, what its Name is, and what 
Method and/or Function FARO Insight should use to evaluate it.  The Gents 
worksheet has columns that correspond to these items. 

Declaring the Type of a feature is your way of telling FARO Insight what you are 
trying measure or create - a point, circle, sphere, etc.  When you measure a feature, 
you are measuring X, Y, Z positions.  By declaring the type, you are telling FARO 
Insight what shaped feature those X, Y, Z positions came from.  Once you declare a 
feature, you cannot change its type.  See “Feature-Fit Reference” for more 
information. 

Declaring the Set of a feature is your way of telling FARO Insight whether this 
feature is going to be measured / calculated, or is a known position from a blueprint 
or a CAD model.  You can create an Actual feature (one that is measured / 
calculated), a Nominal feature (one from a blueprint), or All (which will create both).  
See 

Declaring the Name of a feature is your way of telling FARO Insight what this 
feature will be called.  Whenever you want to use this feature in a calculation, you 
will reference it using its name.  You can edit the name of a feature after it has been 
declared. 

Declaring the Method of a feature is your way of telling FARO Insight if and how 
the Tracker will measure this feature.  There are several predefined methods that can 
be used and you can create your own if you need.  You can change the method of a 
feature after it has been declared.  See “Methods” for more information. 

Declaring the Function of a feature is your way of telling FARO Insight how to 
create this feature (if it is going to be calculated instead of measured) or how to 
modify its position, orientation or size.  One use of functions is compensation for 
tooling that was used for measurement.  Not all features need to be given a function, 
and you can edit the function after it has been declared.  See “Intuitive Function 
Definition” for more information. 

Declaring a feature 
This manual will often use the phrase “Declare an Actual (or Nominal) feature of 
the desired Type” as shorthand for the procedure described here.  Make sure the 
Gents worksheet has the Type, Set, Name, Method, and Function columns displayed 
so you have access to them. 

The easiest way to declare features in FARO Insight is using the Feature Toolbar. 

1. Display the Feature Toolbar.  From the View menu, choose Toolbars, 
then Feature (Alt, V, T, F). 
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The Feature Toolbar 

2. From the Feature Type dropdown, choose the type of feature(s) you 
want to create. 

3. From the Set dropdown, choose the data set of the feature(s) you want 
to create. 

• Choose Actual if you only want to create an actual feature(s).  

•  Choose Nominal if you only want to create a nominal feature(s). 

• Choose All if you want to create both, Actual and Nominal 
feature(s). 

4. Select the Proposed Name text box and type in the name of the feature 
you want to create. 

5. In the Quantity to Create control, enter the number of features you want 
to create. 

• If you only want to create one feature, set this control to 1. 

• If you want to create multiple features, the first feature will have 
the name that is entered in the Proposed Name box.  Subsequent 
features will follow in either numerical or alphabetical order.  For 
example, if Point001 is the first feature, the following features will 
be named Point002, Point003, Point004, etc.  If Point_A is the first 
feature, the following features will be named Point_B, Point_C, 
Point_D, etc. 

6. From the Method dropdown, choose the method that is going to be 
used to measure the feature(s). 

• If you are going create a feature without a method (a calculated 
feature), you can open the Function Toolbar by going to View, 
Toolbars, Function on the menu bar or by pressing the Function 
Toolbar button.  The Function Toolbar will allow you to create the 
feature, insert the constructor function and open the Function 
Editor in one step.  See “Intuitive Function Definition” for more 
information. 

7. Press the Create Feature button to create the feature(s). 

Note:  When declaring Nominal features, the Viewing Condition must be set to the 
Frame that the nominal value is known in (usually the PART Frame) and 
REFERENCE Condition.  See Viewing Data for more information on setting the 
Viewing Condition. 

Setting Feature Properties 
Each feature contains more properties than the required Type, Set, Name, Method / 
Function.  These properties are not always required but can be useful.  These 
properties can be defined before or after the feature is declared.  To define these 
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features before you create the feature, open the Default Properties Dialog by clicking 
on the Set Properties button, , on the Feature Toolbar. 

 
Default Properties Dialog 

The default properties of all features can be set here.  Any changes made here will 
not be applied to all newly created features in this job.  If you want to make the 
changes here affect new jobs, you must go to the Settings menu, and Choose 
Defaults (Alt, S, D).  This dialog is broken down into three or four sections or tabs, 
depending on the feature. 

General Tab 
Type – Type is a drop-down list that identifies the type of feature for which default 
properties will be defined.  When the user changes the feature type, the dialog 
displays the default properties for the selected feature type.  The feature type selected 
here effects every property page.  For example, if the user selects the type ‘Circle’, 
the dialog displays the default general properties, fit-options, actual functions and 
nominal functions for Circles. 

Name – Name is an edit control that displays the default name for the chosen feature 
type.  The user can change the default name on the Feature Toolbar or in the Default 
Properties dialog. 

Group – Group is a drop-down list that displays the group to which new features of 
the chosen type will belong.  If the desired group does not exist, the user may create 
a new group by entering its name here. 

Object – Object is a drop-down list that identifies the object upon which new 
features of the chosen type will be located.  By default, this is the PART object.  See 
“Scale, Objects and Movement” for more information. 

Method – Method is a drop-down list that displays the method for new features of 
the chosen type.  The user can change the default method on the toolbar or in the 
Default Properties dialog.  The user can access the Method Manager (to create and/or 
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edit methods) using the browse button to the right of the method field.  See 
“Methods” for more information. 

Probe – Probe is a drop-down list that displays different target types used in FARO 
Insight.  This option is only available for point features and is used for ADM survey 
functionality only. 

Comment – Comment is an edit control that displays the comment that will be 
assigned to each feature (of the given type) that is created. 

Graphics – Graphics is a set of controls that define how the feature will be displayed 
in the Graphics View.  See “Graphics View” for more information. 

Probe Radius – The Probe Radius field is only available for Point Cloud features.  
FARO Insight uses the probe radius for various Point Cloud operations. 

Tolerance Tab 
See the section entitled 
“Tolerancing in FARO 
Insight” for more information 
on tolerances. 

The Tolerance tab applies to all features except for Frames, Point Clouds, Stations 
and Surface Deviations.  This tab displays the current tolerance options for the 
corresponding feature type. 

 

Tolerances may be set in any or all of the coordinate systems offered by FARO 
Insight (rectangular, cylindrical or spherical).  This is controlled by the ‘Tolerance 
Type’ drop-down list.   

There is also the capability to set three-dimensional tolerancing for size, shape and 
form.  However, different feature types will have different three dimensional 
tolerance settings.  For instance, a circle will have diameter and axial tolerancing, 
while a plane will only have surface tolerancing.   

The ‘±’ and ‘+/-’ controls in the Tolerance and Size/Shape group boxes determine 
whether the corresponding tolerance is uniform bilateral (‘±’) or non-uniform 
bilateral (‘+/-’). In the former case, a single input control is displayed for each value. 
In the latter case, two controls are displayed: one for the upper and one for the lower 
tolerance, as shown for the X and Z coordinates in the preceding figure.  The 
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coordinates can also have their tolerances deactivated as illustrated by the unchecked 
Y coordinate of either figure. 

Note:   For unequal tolerances, a negative value is assumed for the lower tolerance. 
It is not required to enter a negative sign before the tolerance value. A unilateral 
tolerance may be assigned by entering a zero value for either the upper or lower 
tolerance. 

The tolerances entered into and displayed by the dialog will always be considered to 
be at the Reference Condition (Scale = 1.00000).  The values are stored internally at 
this condition, and are calculated for the display condition in the appropriate 
windows.  The ‘Summary’ portion of the dialog box will display the values at the 
viewing condition of the window from which the dialog is opened. 

Fit Tab 
The Fit Tab applies only to circles, cones, cylinders, ellispoids, hyperboloids, 
paraboloids, patches, spheres, and NURBS surfaces.  This tab displays the current fit 
options dialog for the corresponding feature type.  For example, the fit-options tab 
for circles, cylinders, patches, and spheres allow the user to enter the features’ radius 
and indicate whether or not it is fixed.  For paraboloids, the user will see the 
following paraboloids fit dialog. 

 
See “Feature-Fit Reference” for more information. 

Actual and Nominal Tabs 
The Actual and Nominal tab displays a Function Editor dialog for actual or nominal 
features.  The user can program any number of functions to be assigned to new 
actual and nominal features of the chosen type.  The following figure displays the 
Actual tab, the Nominal tab looks and operates the same, but only affects nominal 
features. 
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See “Intuitive Function Definition” for more information. 

Controlling the Layout 
Depending on the circumstances, you will at various times want to display deviations 
between the Actual and Nominal sets, display and change tolerances, show out of 
tolerance conditions, and possibly suppress the display of the features themselves in 
order to get more information on the screen.  The Layout buttons controls these 
functions: 

 

Notice that the first button is similar to what is displayed on the Standard Toolbar; 
the two buttons serve different purposes, as explained here.  When a Layout button is 
depressed, the option is selected.  When all the layout buttons are selected, the 
worksheet looks similar to this: 

 

 
Features Button Controls the display of the Actual & Nominal values.  

When selected, the Actual and/or Nominal values are 
displayed.  Notice, once again, that this button is 
similar to one on the Standard Toolbar, but they serve 
different purposes. 

 
Deviations Button Controls the display of the Actual / Nominal 

deviations.  When selected, the deviations between 
Actual and Nominal position are displayed. 
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Tolerances Button Controls the display of the tolerance values.  When 

selected, the X, Y, and Z tolerance values are 
displayed. 

 
Out of Tolerance 
Button 

Controls the display of Out of Tolerance condition.  
When selected, the deviation between what is 
displayed in the Deviations row and the Tolerances 
row are displayed and highlighted. 

 
Filters Button Controls the display of the column filters.  When 

selected, the column filters are displayed. 

Changing the screen layout 
You can use the Layout in the following manner: 

• To display the Actual / Nominal values (whichever combination has 
been chosen using the Set filter), select the Feature button ; to hide 
them, de-select the button. 

• To display the differences between the actual and nominal, select the 
Act-Nom button ; to hide them, de-select the button. 

• To display the tolerance values (Tol) select the Tolerance button ; 
to hide them, de-select the button. 

• To display the Out of Tolerance condition (OTOL), select the Out of 
Tolerance button .   To hide them, de-select the button. 

• To display the drop-down list filters above the column headers, select 
the Filters button .  To hide them, de-select it. 

Tolerancing in FARO Insight 

FARO Insight provides support for both positional and size/shape/form tolerancing 
on a per-feature basis.   

Actual tolerances are used to check size, shape or form parameters of a given feature.  
For example, an actual radial tolerance of 0.010” may be set to a circle so that when 
a watch window is opened on that circle, the radius of the circle (dR) may be 
checked for uniformity.  If at any location along that circle the dR exceeds the 
assigned actual radial tolerance (in this case 0.010”), the color of the reading in the 
watch window will change.  See the section entitled “Other Windows” for more 
information on watch windows and actual tolerances. 

Conversely, a nominal size/shape/form tolerance will compare an actual solved 
parameter to a nominally entered value.  For example, if a tolerance is placed on the 
radius of a nominal circle, FARO Insight will compare the actual radius to the 
nominal radius and apply the tolerance to the deviation.  If the deviation exceeds the 
tolerance, the color of the deviation in that cell in the Gents sheet will change.  In 
addition, a nominal tolerance may also be used when checking the positional location 
a feature.  If a tolerance is entered for any or all of the X, Y and Z coordinates, the 
deviation of the actual feature’s center is reported and checked against the feature’s 
nominal location.  If any or all of the X, Y and Z deviations exceed the assigned 
tolerance, the color of the deviation in that cell will change. 
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Applying a Nominal Tolerance from the Gents Sheet 
In addition to the Tolerance tab under the Default Properties dialog box, 
modifications to an individual nominal feature’s tolerance setting may be made 

directly from within the Geometric Entities Sheet.  With the Tolerance button, , 
depressed in the Gents sheet, double click in either the X, Y, Z, diameter, radius or 
any other feature specific shape parameter cell in the tolerance row for the feature 
whose tolerance you wish to modify.  (This row will only appear when a nominal is 
present.)  The Tolerance dialog box will appear. 

 
Tolerance Dialog 

Note that only those features that have a specific shape parameter (radius, focal 
length, etc.) will allow for tolerancing of these types.  Like the Default Properties 
dialog, the Tolerance dialog displays one or two input controls in the Tolerance 
group box, depending on whether the user has selected ‘±’ or ‘+/-’ tolerancing. 

Type, Data Set and Group Filters 
The Geometric Entities worksheet has filters that control the data set and feature 
type.  These filters can control both input and output: when you change them, FARO 
Insight updates the worksheet to display all features of the selected type and set.  
These filters can be used to simplify your display for easier viewing, faster screen 
updates, printing particular information to a file or printer, importing data, or 
manually creating features. 

Selecting the feature type and data set 
When the Filters button on the Gents worksheet is selected, FARO Insight displays 
two drop-down filters above the column headers.  One filter controls the type feature 
being displayed; the other controls the feature set being displayed. 

 

 
Type, Set and Group Filters 

• To select the feature type you want to view, click on the Type Filter.  
FARO Insight will display a list of feature types that you can select 
from.  You can only select one at a time. 
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• To select the data set you want to view, click on the Set Filter.  FARO 
Insight will display a list of the data sets that you can choose from. 

• To select the group you want to view, click on the Group Filter.  FARO 
Insight will display a list of the groups that you can choose from. 

• When you are done selecting from the filters, you must click on any 
cell in the Gents worksheet in order to take focus off the filter. 

Note:  You cannot use the Feature Toolbar to create a feature(s) when the Type 
Filter is set to something other than ‘All’ or the feature you are creating.  If you try to 
do so, you will be asked if you want FARO Insight to change the filter to all for you.  
If you choose to, FARO Insight will set the filter to ‘All’ and create the feature(s).  If 
you choose not to, FARO Insight will cancel the operation. 

Manually declaring features 
Using the Type and Set Filters, you can create features without the use of Feature 
Toolbar.  In order to do so, the Feature Toolbar must not be visible.  While using this 
method for creating actual features may be tedious, it can be useful for importing a 
large number of nominal features. 

1. Set the Type Filter to the feature type you want to create.  If you are 
creating a Point, you can select either ‘Point’ or ‘All’. 

2. Set the Set Filter to the data set of the feature you want to create.  If 
you are creating an actual, you can select either ‘Actual’ or ‘All’. 

3. In the Name column on the last row of the Gents worksheet – the only 
blank one – type the name of the feature you want to create. 

4. FARO Insight will assign a Method and Function according to what is 
set in the Default Properties of the feature you created.  You can 
change these if you wish. 

Speed Menu 
The Gents worksheet has a Speed Menu to gain quick access commonly used 
functions.  To access this menu, drag the mouse pointer over feature you want, or 
select a range of features, and click the right mouse button.  The following menu will 
be displayed: 

 

Observations 

Readings 

Edit Functions… 

Edit Properties… 

Delete 

Measure 

Aim 

Paste Special 

Opens the Observations Window of the feature. 

Opens the Readings Window of the feature. 

Opens the Function Editor for the feature. 

Opens the Edit Properties dialog for display properties. 

Deletes the feature from the database. 

Measure the feature with a Tracker. 

Aim the laser at the feature. 

Use the Paste Special command to paste a function in 
the feature. 

You can then select whichever option you desire.  Depending on the feature, and its 
state, not all options may be available.  A Deviations Window can also be accessed 
from the Speed Menu for the appropriate features in FARO Insight VisualPro. 
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Observations 

Overview 
An observation - an X, Y, Z (if using rectangular coordinates) position - is recorded 
when you measure a feature.  When you measure a point, for example, a single X, Y, 
and Z value typically is recorded, but when you scan a plane, thousands of 
observations, or X, Y, Z values, may be recorded, depending on the scan density.  
The required accuracy and the size of the feature determine the number of 
observations required to adequately define a feature. 

In order to prevent the operator from dealing with potentially huge amounts of data 
at a time, FARO Insight provides access to observations in the form of an 
Observations worksheet.  The observations are normally hidden from view, but are 
available when you need them.  You can use the Observations worksheet to detect 
outliers, plot residuals, and selectively use and un-use individual observations to 
improve a feature fit, or diagnose a measurement problem. 

Observations column in the Gents sheet 
FARO Insight will count observations as they are taken and display the total in the 
Observations column of the Gents worksheet.  The total will be displayed as a ratio - 
for example 1/1, 2/2, 3/3, etc.  However, when performing a relocation, the Obs 
column will not update the total until the Relocation has been performed.  For 
example, before the relocation solves, the total may appear as 1/2, 2/3, 3/4, etc.  
Once the relocation has been solved, the totals will be 2/2, 3/3, 4/4, etc. 

Viewing individual observations 
In the Gents worksheet, use the right mouse button to click on the feature whose 
observations you want to view, and choose Observations from the Speed menu.  You 
can also view them by setting focus on the feature and pressing the Observations 
button, , from the Standard Toolbar, or by selecting Observations from the View 
menu (Alt, V, O). 

FARO Insight displays the feature’s observations in a worksheet. 

 
Observations Worksheet for a Point 

The X, Y and Z columns list the observations for the feature.  The Date and Time 
columns provide a time stamp for each observation.  Depending on what type of 
feature is displayed, the worksheet will also list the residuals from the feature fit.  
See “Feature-Fit Reference” for more information. 

Using and un-using observations 
When you use and un-use observations, you do not actually delete them, you simply 
instruct FARO Insight not to use them when calculating the feature.  If you un-use an 
observation, FARO Insight updates the observation count in the Gents worksheet, 
but the residual value(s) are still displayed in the observations window.  Once you 
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have determined which observations (if any) are bad, you can permanently delete 
them.  See “Clearing and Deleting Observations” for more information. 

• To un-use an observation, double-click on the check mark in the Use 
column.  FARO Insight will remove the check mark. 

• To un-use multiple observations, select them with the mouse (multiple 
selections can be made with the SHIFT and CTRL keys in conjunction 
with the mouse) and choose Edit, Un-use Observations (Alt, E, -) from 
the menu bar. 

• To use an un-used observation, double-click on the blank Use column.  
FARO Insight will replace the check mark. 

• To use multiple un-used observations, select them with the mouse 
(multiple selections can be made with the SHIFT and CTRL keys in 
conjunction with the mouse) and choose Edit, Use Observations (Alt, 
E, U) from the menu bar. 

Observations can also be used and un-used from the Calculation Tab of the Edit 
Properties dialog box for a particular feature that has not been formed from a 
constructor function. 

 
Calculation Tab of the Edit Properties Dialog 

• Use All FS and BS Observations: Uses all of the features 
observations. 

• Use Only FS Observations: Uses only observations collected while 
the tracker was in Front Sight Mode. 

• Use Only BS Observations: Uses only observations collected while 
the tracker was in Back Sight Mode. 

• Use Only Most Recent Observations: Uses only observations 
collected during the latest measurement (the number of observations in 
the latest measurement will depend on the Method that was used). 

• Custom: Active when the user individually selects which observations 
to use from the Observations Window. 
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Clearing and Deleting Observations 
When you clear a feature's observations, the feature record and all associated 
functions and fit constraints remain intact.  Clearing observations is useful when you 
want to re-measure a feature and when you want to recycle a job file.  Do not 
confuse clearing observations with deleting a feature. 

Clearing a feature’s observations 
To clear the observations of one or more (but not all) features, use the following 
procedure: 

1. In the Gents worksheet, set focus on the feature(s) whose observations 
you want to clear. 

2. From the Edit menu choose Clear Obs (Alt, E, B), or press F7.  FARO 
Insight prompts you with the following dialog to verify your selection. 

 

3. Click ‘Yes’ to clear the observations.  If you select more than one 
feature in Step 1, FARO Insight prompts you to do this for each feature. 

Deleting individual observations 
You can determine whether some of a feature's observations are outliers by 
selectively using and un-using them and then recalculating the feature.  This allows 
you to determine which observations are bad while keeping the good observations.  
When you determine which observations are outliers, you can selectively delete 
these observations using the following procedure. 

1. In the Observations worksheet, set focus on the observation(s) you 
want to delete. 

2. From the Edit menu, choose Delete (Alt, E, D) or press DEL.  FARO 
Insight prompts you to verify your selection. 

 

3. Choose ‘Yes’ or ‘Yes to All.’ 

4. FARO Insight will display the new feature values and the new number 
of observations. 

Clearing ALL observations in a job file 
There may be times when you are doing the same, or very similar, jobs repeatedly.  
FARO Insight makes this easier by giving you the ability to clear ALL observations 
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from a previous job.  By doing this, most, if not all, of your programming and setup 
is already done for you.  In other words, your original job has just become a 
template. 

Note:  This operation can not be reversed.  Be sure you have a copy of the original 
job before you clear all observations. 

1. From the Edit menu, choose Clear All (Alt, E, A).  FARO Insight 
prompts you to verify your selection. 

 

2. Click ‘OK’ to clear the observations from the entire job file. 

In addition to clearing all of the observations, the Clear All command will clear the 
Operators Tab and the Comments Tab of the Summary Dialog.  It will also reset the 
time and date in the File Tab of the Summary Dialog. 

Readings Worksheet 
The Readings Window is similar in fashion to the existing Observations window, but 
instead of reporting the solved coordinates of the feature, it provides the user a 
reporting of the actual instrument measurements.  It will report both the angles and 
the distances of the point measured, relative to the instrument's frame of reference.  
This functionality only applies to Point features, but can be used for both tracker and 
theodolite measurements. 

Accessing the Readings Window 
The Readings Window can be accessed for any measured point, from either a tracker 
or a theodolite.  The window can also be opened prior to the point being solved, 
since it reports only the values received from the instrument.  Opening the window is 
accomplished from either the View menu (Alt V, A) or from the speed menu that 
opens in either the GENTS sheet or an Observations window. 

 
Readings Window 
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Readings Window Columns 
The Readings window has 15 columns available for display in the spreadsheet.  The 
Station column can be filtered to either ‘All’, to show all the readings, or a particular 
station to show the readings from that station only.  The Readings window can also 
be sorted in a similar manner as the Gents sheet. 

The following table describes the columns in the Readings window. 

Column Description 

Station The station from which the reading was taken. 

Sight The sight (front or back) in which the measurement was 
taken. 

Use Toggle that indicates whether or not each reading should be 
used.  This value is identical to the use status for the 
corresponding record in the Observations window. 

Azimuth, 
Zenith, 
Distance 

The instrument readings of azimuth and zenith angles and the 
linear distance corresponding to the records in the 
Observations window.  All three are present for tracker 
measurements; there is no value in the Distance or d Distance 
columns for theodolite measurements. 

dAzimuth, 
dZenith, 
dDistance 

The deviations between the individual readings from a station 
and the mean of the set of readings from that station. 

Position The object position at which the reading was taken. 

Date The date the reading was taken. 

Time The time the reading was taken. 

Az Sigma Uncertainty of a Station’s Azimuth reading. 

Ze Sigma Uncertainty of a Station’s Zentih reading. 

D Sigma Uncertainty of a Station’s Distance reading. 

Scalar Entities Worksheet 

Scalar Entities 
Scalar Entities - or Sents - are angles and distances: features that are expressed by a 
single value.  Scalar entities may be contrasted with geometric entities, such as 
points, frames and planes: features that are defined by an X, Y, Z location and which 
may also have associated with them an I, J, K direction vector, and possibly a 
size/shape parameter. 

Opening the Scalar Entities worksheet 
The Sents worksheet appears as a spreadsheet within the FARO Insight work area.  
You can maximize it, minimize it, tile it, or cascade it with other windows or 
worksheets in the work area. 

• Press the Scalar Entities button, , on the Standard Toolbar, or, from 
the View menu, choose Scalar Entities (Alt, V, C). 
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If the Sents window is minimized, you can restore it by double clicking on its control 
icon. 

Scalar entity type filter 
Like the Gents worksheet, you can view data in the Sents worksheet through a filter.  
This type filter is used primarily for declaring a Scalar entity, but is also useful for 
viewing or printing purposes. 

 
Type Filter 

• To select the scalar type you want to view, click on the Type Filter.  
FARO Insight will display a list of scalar types that you can select 
from.  You can only select one at a time. 

• When you are done selecting from the filters, you must click on any 
cell in the Gents worksheet in order to take focus off the filter. 

Declaring Scalar Entities 
Each scalar entity that you compute must first be declared in the Sents worksheet.  
Declaring an entity accomplishes two things: it creates a record in the database for 
that entity, and it tells FARO Insight how the entity is to be calculated.  Every Actual 
scalar entity in the Sents worksheet is calculated using an assigned function.  Every 
Nominal is assigned directly by typing the value in the nominal cell. 

Declaring a scalar 
Make sure the Type, Name, Actual, Nominal, and Tolerance columns are displayed 
so you have access to them. 

1. Using the Type filter column, choose the type of scalar (Angle or 
Distance) that you want to declare. 

2. In the Name column of the last row - it’s the only blank one - type the 
name of the scalar you want to create, then press the ENTER key. 

3. Double-click in the scalar's Actual column to open the Function Editor 
and assign a function so that FARO Insight knows how to evaluate it.  
Before assigning a function to a feature, the features upon which the 
function depends must already be declared.  See the chapter entitled 
“Intuitive Function Definition” for more information. 

4. If you know the scalar's nominal value, enter it in the Nominal column. 

5. To specify a tolerance for the deviation from nominal, double-click in 
the Tolerance column. 

FARO Insight displays the Tolerance dialog. 
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Tolerance Dialog 

6. In the Type group box, select the type of tolerance you want to specify 
for the scalar. 

7. For ‘±’ tolerance, enter the tolerance value; for ‘+/-‘ tolerance, enter the 
Lower and Upper tolerance values. 

8. Press the ‘OK’ button. 

Other Windows 

Watch Windows 
A Watch Window displays the difference in position between the Actual (or 
Nominal) values of a selected feature and the current position of the target.  Watch 
windows are useful for checking drift (they allow you to quantify target movement 
without recording position) or for checking conformance of a surface to a shape 
(such as checking a plane for flatness or a circle for roundness).  They are also well 
suited to building, since they allow you to observe the position of a detail relative to 
nominal - in real-time - as you move it into position. 

 
A Watch Window for a Point 

The content of a watch window depends on the type of feature you are watching.  
When you watch a point for instance, FARO Insight displays the difference between 
the feature and the target location.  If you watch a line, FARO Insight displays the 
radial distance from the line. 
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You can have several watch windows open at time, with 3-4 being the typical upper 
limit.  Opening a watch on three different points of a detail allows you to control all 
six degrees-of-freedom of the detail. 

You can change the coordinate sytem for a Watch window using the Display Settings 
Dialog box. 

Using Watch Windows 
Watch Windows have a variety of uses.  Some of them are listed here and described 
briefly. 

• Monitoring Drift - If you measure a set of fixed monuments at the 
beginning of a job, you can periodically watch the original positions of 
these points in order to check for drift. 

• Setting a Detail - If you enter the Nominal coordinates of known points 
on a detail, you can position the detail by zeroing out the differences in 
position from nominal. 

• Checking Flatness - If you measure a plane (or any other feature) you 
can observe the high and low spots (or radial and normal errors) by 
watching the measured feature. 

• Checking Level - If you create a level coordinate system, you can 
watch the height value of various points on a surface relative to a 
vertical datum in order to level a tool. 

Opening a Watch Window 
You can open a watch window on either the Actual or Nominal values of a feature.  
You typically watch Actual features when you are checking drift and watch Nominal 
features when you are setting a detail.  However, these are generalizations, you can 
use watch windows in many different ways. 

1. In the Gents worksheet, set focus on the feature you want to watch. 

2. Click the Watch Window button on the Tracker or Theodolite Toolbar, 
, from the View menu, choose Watch (Alt, V, W), or press F4. 

FARO Insight opens the watch window at an arbitrary location on the screen; you 
can then move, resize or tile it. 

You can open additional watch windows by repeating Steps 1 and 2. 

Watching various features 
The watch windows are user configurable for each type of feature.  A watch window 
is configured by right clicking on an open watch window or by selecting Watch from 
the Settings menu (Alt, S, W) with an open watch window. 
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Point Watch Settings Dialog 

When the settings are configured as above the point watch window will look like 
this: 

 

The Watch Settings Dialog will allow different settings for different feature types.  
The following table lists the types and their allowable settings.  The Build Arrow 
settings are only available in FARO Insight VisualPro and FARO Insight Visual. 

Feature 
Type 

Radial Normal 3D 
Vector 

Offset CPA Build 

Circle X X  X X X 

Cone  X  X X X 

Cylinder X   X X X 
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Ellipsoid  X  X X X 

Frame   X    

Hyperboloid  X  X X X 

Line X   X X X 

Surfaces  X  X X X 

Patch  X  X X X 

Plane  X  X X X 

Point   X   X 

Paraboloid  X  X X X 

Sphere X   X X X 

Station   X    
Watch Window Settings by Feature Type 

Watch Window Tolerance 
If a tolerance is applied to an actual feature, the watch window numbers will be 
displayed in colors to indicating if current position of the target is in our out of 
tolerance.  The settings for display colors can be modified from Tolerance Colors tab 
in the Color Settings dialog box.  This dialog can be accessed from the Colors option 
under the Settings menu (Alt, S, L).  See the section “Watch Windows with a 
Tolerance” in the “Graphics View window” Chapter for more information on watch 
windows with a tolerance. 

 
Tolerance Colors Tab in the Color Settings Dialog 

Watch Nearest Nominal Windows 
FARO Insight features a second type of watch window called a Watch Nearest 
Nominal Window.  Watch Nearest allows you to open a single, large watch window 
that displays the difference in position between the probe and the nearest nominal 
point.  As you move the probe from point to point, FARO Insight will determine, 
based on proximity, which is the appropriate nominal point with which to compare 
the probe location. 

1. From the View menu, choose Watch Nearest Nominal, Point (Alt, V, 
N, P). 
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FARO Insight will open a Watch Nearest Point window.  The window 
remains blank until the probe is moved to within the Lock-on 
Threshold of a nominal point (see Setting Thresholds for Watch 
Nearest Windows below). 

 

2. Move the probe to the approximate location of any nominal point. 

When the distance between the probe and the nominal point is less than 
the Lock-on Threshold, FARO Insight will display the difference in 
position between the probe and the coordinates of the nominal point. 

When the probe is moved to a distance greater than the Drop-off 
Threshold from the point, the watch window will clear until the probe 
is again moved to within the Lock-on Threshold of a nominal point. 

3. Initiating a measurement by pressing F3, or by using any of the menu 
options, will measure the actual point that corresponds with the 
nominal point being watched.  If no acutal point exists in the 
spreadsheet, an actual point that has the same name as the nominal 
point will be created. 

Setting Thresholds for Watch Nearest Windows 
When using a Watch Nearest Nominal Window the Lock-on and Drop-off thresholds 
must be set.  These parameters will tell FARO Insight when to lock on and drop off 
of specific nominals. 

1. From the Settings menu, select Watch Nearest Nominal Point (Alt, S, 
N).  FARO Insight displays the Nearest Nominal Point Watch Settings 
dialog. 
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2. Enter a value for the Lock-on Threshold.  This is the maximum 
separation between the probe and a nominal point before which FARO 
Insight will begin to compare the probe position to the nominal point. 

3. Enter the Drop-off Threshold.  This is the minimum separation between 
the probe and a nominal point beyond which FARO Insight will no 
longer compare the probe position to the nominal point. 

The program will not accept Drop-off Threshold values that are less 
than or equal to the Lock-on Threshold value. 

4. Press the ‘OK’ button. 

Magnify Windows 
A Magnify Window displays the contents of one cell within a column in a window 
that can be resized and placed on the screen for increased visibility.  You can 
magnify the contents of virtually any column, but the most common ones are the 
Name, Obs, Method, and State columns.  Magnify windows allow you to see, from a 
distance, which feature has the focus, whether or not it has been observed, what the 
method of observation is, whether or not the feature fit was successful, etc. 

 
Magnify Windows for Name, Obs and Method 
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When you magnify a column, FARO Insight opens a window that displays the 
contents of that column for the feature that has the focus.  When you change focus to 
another feature, the values for that feature in the columns you have magnified are 
displayed.  For example, if you magnify the Name column, FARO Insight displays 
the name of whichever feature has the focus. 

Magnifying a column 
1. In the Gents worksheet, set focus on any cell in the column you want to 

magnify. 

2. Click the Magnify button on the Standard Toolbar, , or from the 
View menu, choose Magnify (Alt, V, M). 

FARO Insight opens a window with the contents of the column displayed.  You can 
then move and resize the window as necessary. 

Graph Windows 
A Graph window displays a series of data that shows the mean value, standard 
deviation, minimum value and maximum value of the data.  Graph windows are ideal 
for plotting residuals from a feature fit, and for plotting a set of coordinates in order 
to detect trends in data. 

 
A Graph of Observations 

The mean, minimum, and maximum values are marked with coarse dotted lines, and 
the standard deviation with fine dotted lines.  Magnitude is displayed along the 
vertical axis and the data is numbered consecutively from left to right along the 
horizontal axis for identification purposes. 

Graphing a series of values 
You can graph data from the Geometric and Scalar Entities worksheets, as well as 
from an Observations worksheet. 

1. Select the cells whose contents you want to graph.  If you select a range 
of columns, FARO Insight displays only the first column. 

2. Click the Graph button from the Standard Toolbar, , or from the 
View menu, choose Graph (Alt, V, R). 



104  •  FARO Insight Worksheets FARO Insight 5.0 User's Guide 

3. FARO Insight will prompt you for a title for the graph.  You may enter 
a name if so desired, but it is not necessary.  To enter a graph title, type 
in the name and click the OK button.  To continue with out entering a 
title, simply click the Cancel button. 

FARO Insight opens a window with the selected data in a graph.  You 
can then move and resize the window as necessary. 
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Importing, Reporting, Exporting 
and Printing 

Importing 
You can import ASCII text data directly into the Actual, or Nominal records in the 
Gents worksheet, or into the Observation worksheet for a geometric entity.  FARO 
Insight currently contains two methods for importing data, Import and Enhanced 
Import.  

The Import feature may be used to import nominal circle, line, plane, point, sphere, 
and cylinder features directly into a Gents worksheet or the names of any actual 
feature.  Import may only create one type of feature at a time.  The Enhanced Import 
feature may be used to import actual names and nominal point, line, circle, or plane 
features simultaneously.  The Enhanced Import may create up to four features with 
the same name (two actual and two nominal) at a time. 

It is also possible to import IGES and CATIA files with FARO Insight VisualPro.  
See the chapter covering FARO Insight VisualPro for more details. 

Standard Import 

Import File Formats 
The data you import may be in a comma, space, or tab delimited ASCII file.  The 
Enhanced Import is capable of importing ASCII text or a design file.  If you are 
importing Nominal features into the Gents worksheet, each record may begin with a 
feature name. However, if no name is specified, FARO Insight will assign a default 
name.  Subsequent fields in each record must contain the coordinates, vector 
components, radii, etc., necessary to completely describe a feature of the type being 
imported.  If you are importing observations, names are not permitted, and there can 
be only three columns of coordinate data. Native ManCAT *.REF files are not 
useable unless modified. 

If you want only to declare Gent or Sent names, the import file should contain only 
valid feature names listed in one column 

Importing Nominal Features 
Nominal circle, line, plane, point, sphere, and cylinder features can be imported 
directly into a Gents worksheet using the Import feature. 

1. Select Nominal from the Set filter. 

2. Select the appropriate feature type from the Type filter. 
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3. Make sure the displayed unit of length matches the units of the import 
data.  If not, change the display units to match the import units. 

4. From the File menu, choose Import then Standard (Alt, F, I, T). 

FARO Insight displays the Import File dialog box. 

 
         Import File dialog 

5. Press the ‘Browse’ button and use the Browse dialog to select the file 
that contains the Nominal coordinates. 

The summary in the Import File dialog should indicate that the data is 
in the set and type you selected in Steps 1 and 2.  If not, close the 
dialog and start over at Step 1. 

6. By pressing ‘Edit’, you can open the import file in a text editor to 
confirm it is the correct file or make changes to the file. 

7. Select the Basis button to open the Display Settings dialog.  Change the 
settings to the desired frame, scale, and coordinate system settings for 
the import data and click ‘OK’ to return to the Import File dialog.  
Normally, nominal features are to be imported in the PART frame and 
REFERENCE condition. 

8. Select the import order of the nominal feature coordinates in the text 
file using the drop down list arrow on the right side of the selection 
box.   

 
Import File dialog with the Order drop down list activated 

9. Press ‘OK’ to import the features. 

Importing Actual features and observations 
The ability to import observations allows you to take data acquired with another 
measurement system and analyze it as though it was measured within FARO Insight. 
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1. Set the displayed unit of length to match the units of the import data. 

2. Set the display frame to ‘@STATION01’ and the condition to 
CURRENT. 

3. Declare an Actual feature of the Type you want to import.  Assign a 
method to it. 

4. Press the Observations button, , or press the right mouse button on 
the feature whose observations you want to enter and choose 
Observations from the speed menu that appears. 

FARO Insight displays the Observations Window. 

 
Observations Window 

5. From the File menu, choose Import, then Standard (Alt, F, I, T). 

FARO Insight displays the Import File dialog. 

 
Import File dialog 

6. Press the ‘Browse’ button and use the Browse dialog to select the file 
that contains the import observations. 

The summary in the Import File dialog should indicate that the data is 
in the Actual set, and the frame and condition you selected in Steps 2 
through 3.  If not, close the dialog and repeat Step 2. 

7. By pressing ‘Edit’, you can open the import file in a text editor to 
confirm it is the correct file or make changes to the file. 

8. Select the import order using the drop down list arrow on the right side 
of the selection box. 
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Import File dialog with the Order drop down list activated 

9. Click ‘OK’ to import the observations. 

10. Close the observation window. 

Enhanced Import 
The Enhanced Import feature may be used to import multiple features 
simultaneously.  For example, a single data file may be imported to create all of the 
entities necessary to best fit to tooling ball values. 

Data must be in either ASCII text (*.csv, *.txt, or *.prn) or design (*.des) format. 
ASCII text files must be in the following format: name, x, y, z, i, j, k.  The i, j, k 
values are only needed if the imported feature has a vector associated with it. 

Selecting and Reading in Files 
1. Make sure the displayed unit of length matches the units of the import 

data. 

2. Under the File menu, select Import, then Enhanced Import (Alt, F, I, 
E).   

The Enhanced Import dialog box will appear: 

 
Enhanced Import dialog 
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3. Select the name of the import file by either typing it in the Name box or 
open the browser by pressing the ‘Browse’ button, then select the 
import file.  In the browser, the ‘List Files of Type’ filter may need to 
be set to view the desired files. 

4. Select the Basis button to open the Display Settings dialog.  Change the 
desired frame, scale, and coordinate system settings for the import data 
and press OK to return to the Enhanced Import dialog. 

5. Set the Type of file to match the format of the import file by clicking 
on the pull down menu next to Type.  The General Import type is used 
for ASCII text. 

6. Select the import order using the pull down menu next to Order. 

7. Press ‘Read’ and FARO Insight will list all of the names of the features 
from the import file in the Feature Selection box.  If the import file 
does not match the designated file type, an error message will appear. 

Defining the Features to be Created 
1. Select the items to be edited.  Different entities may be created for each 

item in the import file by selecting the item in the Feature Selection 
box.  The feature selection box is a multi-select list (more than one item 
may be selected by pressing the SHIFT key to select adjacent items, or 
hold the CTRL key to select non-adjacent items). 

2. Select the type of features to create.  The Enhanced Import will allow 
four features (two actual and two nominal) to be imported at a time for 
each item in the import file.  The types of features may be selected 
from the pull down menus under ‘Nominal Features’ and ‘Actual 
Features’ respectively.  If less than four features are needed, select 
‘<<no feature>>’ from the pull down menu.  If there is an item in the 
import file that does not need to be used, select that item from the 
Feature Selection list and click on ‘Skip Feature.’ 

In the example below, we will create a nominal point, an actual point, 
and an actual plane for items “pt1, pt5, and pt9.” 

 
Enhanced Import Dialog 
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3. The ‘Overwrite’ drop down menus determines if the values in the 
import file should overwrite existing values in the Gents worksheet. Set 
each Overwrite to Yes or No. 

Other Settings 
The ‘Mirror Axis’ pull down menu allows an axis and vector to be selected as a line 
of symmetry. FARO Insight will change the sign of the value in the designated 
direction.  For example, if the X-axis is designated as the mirror axis and the X value 
in the import file is positive, the sign of the X value would be changed to negative. 
Select the Mirror Axis if necessary.  

The ‘Use Default Properties’ will create the actual features and give them the default 
properties set from the Settings, Default Properties menu. 

Processing the File to Create Features 
Press ‘Process’ and FARO Insight will import the nominal entities and create 
corresponding actual entities as defined in the previous sections. 

FARO Insight Standard and Custom Reports 
FARO Insight can generate Standard and Custom reports from which user selected 
information can be printed and exported. 

Preparing a Standard Report 
A Standard Report can be created from any standard spreadsheet style window in 
FARO Insight.  When a valid window is open, the Standard Report toolbar button 
and menu option will become available.   

Open the window from which the operator would like to make a Standard Report.  

From the Reports menu select Standard (Alt R, S) or click the  toolbar button.  
The Standard Report dialog box will appear. 

 
Standard Report Dialog 

This dialog box allows the user to select what data to report.  The ‘Show Column 
Headers’ checkbox may be checked if the user would like to see column headers 
appear at the top of the report.  If ‘Selected Cells’ is selected, any/all cells that are 
currently highlighted in the last active window will be printed.   
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Sample Standard Report with selected Cells and Column Headers options selected 

If ‘Selected Rows’ is selected, the entire row will be printed for any/all cells that are 
currently highlighted in the last active window.  If ‘All’ is selected, the entire active 
sheet will be printed.  The column width in the report will be based off of the column 
with that is displayed in the window from which the reported information is selected. 

Preparing a Custom Report 
A Custom Report can be created from a Geometric Entities worksheet, a Scalar 
Entities Worksheet, an Observations Window, or a Deviations Window.  When a 
valid window is open, the Custom Report toolbar button and menu option will 
become available.   

Open the window from which the operator would like to make a Custom Report.  

From the Reports menu select Custom (Alt R, C) or click the  toolbar button.  
The Custom Report dialog box will appear. 

 
Custom Report Dialog 

This dialog box allows the user to select what data to print.  Again, if ‘Selected 
Rows’ is selected, the entire row will be printed for any/all cells that are currently 
highlighted in the last active window.  If ‘All’ is selected, the entire active sheet will 
be printed.  A Custom Report generated from an Observations Window or a 
Deviations Window will not allow the operator to use the ‘Selected Rows’ option.  In 
this case, only the entire window may be reported. 

Adjusting the Settings of a Customized Report 
With a FARO Insight Custom Report, the user can customize what information will 
be displayed in the report’s headers and footers.  In addition, the user can customize 
what information will be displayed in the report for each type of item in the active 
window.  

The ‘Settings’ button in the Custom Report dialog box will display the Custom 
Report Settings dialog box. 
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Custom Report Settings Dialog for a report from the Gents sheet 

From the Layout tab, the user is able to define what information will appear as 
headers or footers in the Custom Report.  Items selected for the ‘Report Header’ will 
be displayed only at the top of the first page of the Custom Report.  Items selected 
for ‘Page Header’ will be displayed at the top of every page of the custom report.  
Items selected for ‘Page Footer’ will be displayed at the bottom of every page, and 
finally, items checked ‘Hide’ would not be displayed on any pages. 

The other tabs in the Report Settings dialog box allow the user to select what data is 
printed for each type item specific to the active window from which the report is to 
be generated.  With the Report Settings dialog box open, the user can click on any of 
the tabs and select what information it to be printed to the report.  Note that the tabs 
will be different depending upon what window the report is being generated from. 

 
Report Settings for a Circle 

Changes made in the Report Settings dialog will be considered a global change in 
FARO Insight.  This means that any changes will be remembered by FARO Insight 
and will be the same in any other job file opened.   

In addition to the ‘Settings’ button in the Custom Report dialog box, the Report 
Settings dialog box may be accessed directly through menus.  To access the Report 
Settings dialog box using FARO Insight menus, click on the Reports menu, then 
Settings (Alt, R, T).  The user can then choose the Report Settings dialog box for the 
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Geometric Entities worksheet, the Scalar Entities worksheet, the Observations 
Window, or the Deviations Window. 

 
Selecting the Report Settings Dialog from the menus 

Once all settings have been arranged as desired, a Report Window can be created. 

 
Custom Report Window 

Print, Print Preview and Print Setup 
Once a Report window has been generated or if a Graphics window is opened, all of 
the Print options in FARO Insight become available.  From the File menu, select 

Print Preview (Alt, F, V), or click on the  toolbar button.  This will permit the 
user to see a preview of what will physically be printed.  If it is not necessary to view 
the document before it is printed, the user may go directly to printing.  Again from 

the File menu, select Print (Alt, F, P), or click on the  toolbar button.  FARO 
Insight will send the document to the currently configured default printer to be 
printed.  If it is necessary to make changes to the print properties, either click on the 

 toolbar button, or from the File menu, select Print Setup (Alt, F, U), and make 
the appropriate print setup changes. 

If only the Geometric Entities Sheet, an Observations window, or a Deviations 
window is opened, only the Print and Print Setup options are available.  The user can 
highlight specific cells in one of these windows and then select the Print option to 
send the data to a printer. 

Exporting 
FARO Insight has multiple exporting capabilities. 

• Data can be exported to text files in the form of Standard or Custom 
reports. 
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• Data can be exported through a linked Microsoft Excel Macro or 
directly to a Microsoft Excel worksheet. 

• Data can be exported as a CATIA file (covered in the chapter on FARO 
Insight VisualPro). 

• Data can be exported in a C3DF Report. 

• NURBS surfaces can be exported to an IGES file (covered in the 
chapter on FARO Insight VisualPro). 

• Point clouds can be exported to a text file (covered in the chapter on the 
Graphics View Window). 

• Point cloud can be exported to an IGES file (covered in the chapter on 
FARO Insight VisualPro). 

Note: The export dialog boxes described in the following sections contain options 
that the user can use to customize the export.  These options are reset to default 
values when FARO Insight is closed. 

Exporting Data to Text Files 
Once a Report window has been generated, the report can be exported to a text file.  
The Report Export dialog box can be accessed by selecting Export from the File 
menu, and then by selecting Report (Alt, F, E, R).  The name and location of the file 
to be created will be displayed in the ‘Destination File’ box.  The user may click the 
‘Browse’ button to search for the proper directory.   

FARO Insight can create text files with three different file extension options: *.txt, 
*.prn, or *.csv.  Once a proper path and file name with one of these three extensions 
is entered, the ‘OK’ button will become active.  The user can then click the ‘OK’ 
button to save the file. 

 
Export Dialog 

In addition, there are three options available when exporting.  By clicking the 
appropriate box, the operator can choose to append an existing file, can choose that 
have FARO Insight not warn the user that an existing file will be overwritten and can 
choose to not export the header/footer information specified in the Report Settings 
dialog box for Custom Reports.  For Standard Reports, the Header\Footer 
Information will pertain to the file Summary information. 

The user can also export data directly to a text file by highlighting the desired cells, 
and by selecting Export, then Text from the File menu (Alt, F, E, T). 
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Export Dialog 

When exporting data directly to a text file, the user has several options.  Four options 
are ‘Selected Cells’, ‘Selected Rows’, ‘All’, and ‘Show Column Headers.’  These 
options work identically to the options when generating a Standard Report Window.   
The ‘Append File’, ‘Suppress Overwrite Warning’, and ‘Suppress Header\Footer 
Information’ options work identically to the Export Report options. 

Once the desired options have been selected and a file name with either a .txt, .prn, 
or .csv file extension has been entered, the ‘OK’ button will be activated and the data 
can be exported.  After the ‘OK’ button is selected, FARO Insight will generate and 
open a Standard Report window and the text file that was created or appended. 

Exporting to a Customized Microsoft Excel Macro 
Note: This option only available on systems that have MS Excel installed 

You can easily export your data to a custom report created with an Excel Auto Open 
macro.  Please note a user can not select a set of data for macro processing that is 
incompatible with the selected macro.   

Configuring FARO Insight to run a custom Excel Macro 
1. Open FARO Insight Settings file from the FARO Insight program 

group. 

2. Find the Section labeled [Excel]. This section should appear similar 
the following: 
[Excel] 

excel=C:\Program Files\Microsoft Office\excel.exe 
dir=C:\FARO\Insight\books 
transfer=insight.csv 
printer=printer.xls 
workbook=workbook.xls 

Ensure that the filename path found at the line,  "excel = " is 
configured to point to the proper location of the Excel executable. 

3. Increment the line "workbooks = n " by n + 1 too add a new 
workbook macro. 

4. Add a line below any existing macro add-ons using the following 
format. 
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<num>=<workbook name>, <export option>, <description in 
quotes> 

<num> = workbook index  number 
<workbook  name> = the name of the excel file that contains the 
macro 
<export option> = the type of data that will be sent to the  
"insight.csv" data file used by the Excel macro. 
These options are: 
    1 - Geometric Entities. 
    2 - Geometric Entities and Observations. 
    3 - Scalar and Geometric Entities. 
    4 - Scalar and Geometric Entities and Observations. 
    5 - Scalar Entities. 

<description> = Brief description of the macro. Use "\n" to mark 
carriage returns in the description text. 

Example: 

workbooks=2 
default=2 
1=printer.xls, 5, "Print all scalars.\n Return 
to FARO Insight" 
2=sample.xls, 1 ,”Print all Gents.\n Return to 
FARO Insight” 

5. Find the line under "workbooks=" labeled "default=". Enter the 
index number of the macro file that you want to appear as the default 
selection in the Microsoft Excel Macro Dialog box. 

Note:  The text entered into the FARO Insight Settings File must be formatted 
exactly as shown above.  If it is not, the custom Excel Macros will not run properly. 

To run the Excel Macro 
1. In FARO Insight, select Microsoft Excel Macro under the Tools menu 

(Alt, L, E). 

  
Tools Menu 

The Select Microsoft Excel Macro dialog will appear. 
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Select Microsoft Excel Macro Dialog  

2. Select the Workbook from the drop down menu to be used and press 
the ‘OK’ button. 

FARO Insight does not create the report macro automatically.  See your Excel 
manual for instruction on how to create a report macro. 

Exporting Data to a Microsoft Excel Workbook 
Note: This option only available on systems that have MS Excel installed 

Once a Report window has been generated, the report can be exported to a Microsoft 
Excel workbook.  The export is identical to a text export except that FARO Insight 
will automatically launch MS Excel and open the text file.  The FARO Insight 
Settings file from the FARO Insight program group must be modified as indicated in 
steps 1 and 2 from the section in this chapter entitled “Printing to a Customized 
Microsoft Excel Macro.” 

The Export dialog box can be accessed by selecting Export from the File menu, and 
then by selecting Microsoft Excel (Alt, F, E, E).  The name and location of the file to 
be created will be displayed in the ‘Destination File’ box.  The user may click the 
‘Browse’ button to search for the proper directory.   

FARO Insight can create text files with three different file extension options: *.txt, 
*.prn, or *.csv.  Once a proper path and file name with one of these three extensions 
is entered, the ‘OK’ button will become active.  The user can then click the ‘OK’ 
button to save the file. 

 
Export Dialog 
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In addition, there are three options available when exporting.  By clicking the 
appropriate box, the operator can choose to append an existing file, can choose that 
have FARO Insight not warn the user that an existing file will be overwritten and can 
choose to not export the header/footer information specified in the Report Settings 
dialog box for Custom Reports.  For Standard Reports, the Header\Footer 
Information will pertain to the file Summary information. 

C3DF Reporting 
C3DF (Chrysler CMDANA CMM DATA FORMAT) is a specific report format that 
DiamlerChryser uses to send measurement data to a central CMM database.  FARO 
Insight can create reports using this format. 

To create a C3DF report, open up the Gents sheet and highlight the features that need 
to be reported.  Note that the first 10 characters of a feature’s name must be unique 
to the job file.  FARO Insight will automatically report the proper information that 
needs to be exported for each feature type, so it is only necessary to highlight any 
cell in a feature’s row for it to be reported properly.  If only one cell is selected, 
FARO Insight will assume that all features are to be exported.  Once the proper cells 
have been selected, the user clicks on the File menu, then Export, and then C3DF 
(Alt, F, E, 3).  The following dialog box will come up. 

 
C3DF Export Dialog 

Similar to the regular Export dialog box, the destination file name and location must 
be specified.  The file can only have a *.C3D extension name.  Once a proper file 
name and location is entered, the ‘OK’ button will become activated.  Press ‘OK’ to 
save the file.  FARO Insight will then automatically open the file for the user to 
view.  If the ‘Suppress Overwrite Warning’ option is checked, then FARO Insight 
will not warn the user that the file name specified already exists and will overwrite 
the old file with the new one. 

C3DF File Headers 
The ‘Settings’ button in the C3DF Export dialog box will open up the C3DF File 
Headers dialog box.  This dialog can also be accessed  by selecting Settings then 
C3DF (Alt, S, 3) from the main menus.  This dialog box allows the user to enter the 
appropriate header information that will be specific to the report. 
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C3DF File Headers Dialog 

Adjusting fields in the C3DF File Headers dialog box 
Fields available in the C3DF File Headers dialog box can be added, deleted, or 
modified by making changes to the ‘insight.ini’ file.  This file can be accessed from 
the Microsoft Windows Start menu by selecting Start, Programs, FARO, FARO 
Insight 5.0, and finally, FARO Insight Settings.  The default ‘insight.ini’ file profile 
looks like the following figure. 

 
Default ‘insight.ini’ file settings for the C3DF File Headers section 

In general, the section must contain a count entry followed by at least one file header 
row description entry.  The count entry must contain a positive integer value that 
indicates how many file header rows will be used in the C3DF file header.  The 
index numbers of the file header row description entries must begin at one and 
increase sequentially by one.  There must be at least as many row description entries 
as specified by the count value.  If the count value is less than the number of row 
description entries present, the row description entries with indices greater than the 
count value are ignored.  Furthermore, each file header row description entry must 
conform to one of the following formats: 

Format 1: 

<index> = “<name>”,Edit,<max string length>,“<default string>” 
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The “name” field must be a text string contained in quotation marks.  The string may 
contain spaces but may not exceed the length specified by the C3DF 3.0.0 
specification.  Refer to the C3DF 3.0.0 specification for details. 

The “Edit” field indicates that the file header row specified by the index shall be 
presented in the C3DF File Headers Dialog as an edit control.  The control shall limit 
the length of the text string to the number of characters specified in the subsequent 
field. 

The “default string” field must be a text string contained in quotation marks.  The 
string may be empty if no default text is desired and the string should be in all capital 
letters. 

Format 2: 

<index> = “<name>”,DropList,“<comma-separated list of strings>”,“<default 
string>” 

The “name” field must be a text string contained in quotation marks.  The string may 
contain spaces but may not exceed the length specified by the C3DF 3.0.0 
specification.  Refer to the C3DF 3.0.0 specification for details. 

The “DropList” field indicates that the file header row specified by the index shall be 
presented in the C3DF File Headers Dialog as a drop list control.  The control shall 
offer a list of text selections constructed from the comma-separated list of strings 
supplied in the subsequent field.  The list of strings should be in all capital letters. 

The “default string” field must be a text string contained in quotation marks.  
Furthermore, the string supplied must match one of the strings supplied in the 
comma-separated list.  An empty string is not allowed.  The string should be in all 
capital letters. 

Format 3: 

<index> = “<name>”,DateTime,“<date-time format string>”,“” 

The “name” field must be a text string contained in quotation marks.  The string may 
contain spaces but may not exceed the length specified by the C3DF 3.0.0 
specification.  Refer to the C3DF 3.0.0 specification for details. 

The “DateTime” field indicates that the file header row specified by the index shall 
be presented in the C3DF File Headers Dialog as an edit control.  The control shall 
limit the length of the text string to the length implied by the format string specified 
in the subsequent field.  The control shall also check the user's input against the 
supplied format string for correctness.  The format string may contain any 
permutation of the codes “YY”, “MM”, “DD”, “HH”, “NN”, “SS” as well as white 
space and punctuation characters for formatting.  However, the string supplied with 
FARO Insight is the one that conforms to the C3DF 3.0.0 specification.  It should 
only be changed if it the C3DF specification for date-time strings changes. 

The “default string” field must be an empty string contained in quotation marks.  It is 
reserved for future developments. 

If the user adds more than 14 rows to the file header, the C3DF File Headers Dialog 
will contain a vertical scroll bar.  The scroll bar will allow the user to scroll the 
additional rows of controls into view for editing. 

Note: For all three formats, the text “Edit”, “DropList”, and “DateTime” is case 
sensitive. 
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Creating and Printing Seagate Crystal Reports 
Separate from the FARO Insight Standard and Custom Reports, FARO Insight offers 
the Seagate Crystal Report as another format for creating reports.  The Seagate 
Crystal Report generates a customized report form in which selected information 
from FARO Insight can be displayed.  Features include the ability to: 

• Customize the report content. 

• Change the report format settings. 

• Perform complex queries, sorting, and grouping. 

• Save the current report for future printing. 

• View the existing report with a print preview. 

Customizing the Report Content  
Three default report formats can be set up one for the Geometric Entities 
Spreadsheet, one for the Scalar Entities Spreadsheet and one for the Observation 
Spreadsheet.  You can change the options for any of these reports and save the 
changes as a new Default. 

1. From the Tools menu, choose Seagate Crystal Report, and then 
Create… (Alt L, R, C).  

2. Select the type of report, fields to be included in the report and whether 
actual and/or nominal data are to be included.  The left and right arrows 
move selected fields between the Available and Selected areas.  The 
double arrow moves all fields.  The Up and Down arrows change the 
order selected items. 

 
FARO Standard Report – Customize Dialog 

Changing the Report Format Settings  
The report fonts, margins and titles can be set and saved as default. 

1. From the FARO Standard Report - Customize dialog box, select the 
‘Settings…’ button. 
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2. Enter the Report Title, Company Information, Margins, Precision and 
Fonts. 

 
FARO Standard Report – Settings Dialog 

3. The ‘Defaults…’ button allows you to restore the original settings. 

Performing Complex Queries, Sorting, and 
Grouping  
The Seagate Crystal Report enables you to filter a report based on field values, group 
features and sort hierarchy. 

From the FARO Standard Report - Customize dialog box, press the ‘Advanced…’ 
button. 

 
FARO Standard Report - Advanced Options Dialog 
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Queries - Allows the user to select the field to set the filtering attribute.  The 
Relation and Value boxes will adjust depending on the Field that is selected.  The 
Reset button clears the current Query.  The Cancel button closes the dialog and does 
not save any changes.  The Queries can be previewed and printed from the FARO 
Standard Report - Customize dialog. 

Examples:  

• To view all features whose name starts with string "dat" – Select 
"Name" in the Field and select "Starts With" as the Relation and then 
enter "dat" in Value1 and press OK. 

• To view all features whose names end with string "xyz" and with 
Tolerance less than 0.5 – Select the "Name" in the Field and select 
"Ends With" in Relation and then enter "xyz" in Value1.  Then select 
"Tol" in the Field and "<" in Relation and then Enter 0.5 in Value1. 

Grouping - Provides the user with 3-levels of grouping by Field.  In the case the 
user wishes to reselect/nullify his grouping at a level, then all the below groups are 
also nullified. 

Examples:  

• To group by "Type" the user needs to select the "Type" in Group I 
combination box.  

• To group by 2-levels the user selects a field in the Group I as well as 
Group II combination box.  

Sorting - Allows the user to sort by any Field with up to three sort levels.  By 
default the sorting is done in increasing order for any field specified.  The user can 
override this by checking the Descending checkbox and the field will be sorted in 
descending order. 

Saving the Current Report  
Seagate Crystal Reports can be saved for future printing by FARO Insight.  The 
reports are saved as ".rpt" file. 

From the FARO Standard Report - Customize dialog box, press the ‘Save As…’ 
button. 

 
Save As Dialog 
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Previewing a Report 
Seagate Crystal Reports can be previewed prior to printing or saving. 

From the FARO Standard Report - Customize dialog box, press the ‘Preview…’ 
button. 

 
Preview Window 

The Preview Window displays the data along with all the current settings and queries 
applied. Icons along the toolbar allow for direct printing/exporting, display sizing, 
and moving between pages.  

The   buttons to move to the next page, previous page, top of the report 
and end of the report are available.  

The print button, , prints directly to the default printer. 

The export button, , is for exporting to a user selected file type.  Pressing this 
button opens the export dialog box. 

 
Export Dialog 

The report can be exported in many different formats (CSV, Text, and Tab 
Separated, Word, Excel, Access, HTML, etc…) and to a variety of destinations (Disk 
File, Mail, Exchange Folder … etc).  The user is also prompted for any other 
information that is required for exporting. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

1. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

2. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

3. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

4. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 



130  •  Graphics View Window FARO Insight 5.0 User's Guide 

Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

1. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

2. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

1. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

2. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

3. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

4. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

5. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

6. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

1. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

2. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

3. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

4. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

5. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   
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Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 

Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 
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Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 

Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

5. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

6. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 
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When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 

 
Polygon Select Options Dialog 

7. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 
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Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

8. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 

 

Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 
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Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 

Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
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screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 

 
Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 
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Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 

These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
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button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 
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Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 

Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

3. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

4. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

7. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

8. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

9. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

10. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

11. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

12. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

6. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

7. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

8. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

9. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

10. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   
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Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 

Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 
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Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 

Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

9. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

10. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 
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When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 

 
Polygon Select Options Dialog 

11. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 
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Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

12. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 

 

Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 
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Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 

Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
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screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 

 
Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 



174  •  Graphics View Window FARO Insight 5.0 User's Guide 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 

These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
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button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 
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Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 

Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

5. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

6. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 



186  •  Graphics View Window FARO Insight 5.0 User's Guide 

Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

13. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

14. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

15. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

16. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

17. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

18. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

11. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

12. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

13. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

14. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

15. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

13. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

14. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

15. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

16. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 
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Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

7. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

8. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

19. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

20. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

21. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

22. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

23. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

24. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

16. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

17. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

18. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

19. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

20. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

17. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

18. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

19. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

20. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 
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Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

9. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

10. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

25. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

26. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

27. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

28. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

29. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

30. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

21. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

22. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

23. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

24. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

25. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

21. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

22. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

23. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

24. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 
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Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 



FARO Insight 5.0 User's Guide Graphics View Window  •  237 

These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 



244  •  Graphics View Window FARO Insight 5.0 User's Guide 

button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

11. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

12. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 



FARO Insight 5.0 User's Guide Graphics View Window  •  249 

Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

31. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

32. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

33. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

34. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

35. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

36. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

26. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

27. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

28. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

29. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

30. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 



FARO Insight 5.0 User's Guide Graphics View Window  •  253 

Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

25. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

26. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

27. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

28. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 
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Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

13. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

14. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

37. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

38. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

39. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

40. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

41. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

42. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

31. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

32. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

33. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

34. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

35. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

29. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

30. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

31. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

32. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 
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Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 



284  •  Graphics View Window FARO Insight 5.0 User's Guide 

 
Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

15. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

16. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 



290  •  Graphics View Window FARO Insight 5.0 User's Guide 

Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

43. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

44. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

45. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

46. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

47. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

48. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

36. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

37. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

38. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

39. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

40. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

33. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

34. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

35. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

36. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 
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Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

17. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

18. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

49. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

50. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

51. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

52. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

53. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

54. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

41. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

42. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

43. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

44. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

45. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

37. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

38. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

39. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

40. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 



FARO Insight 5.0 User's Guide Graphics View Window  •  319 

Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 
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button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

19. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

20. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

55. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

56. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

57. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

58. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

59. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

60. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 



334  •  Graphics View Window FARO Insight 5.0 User's Guide 

Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

46. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

47. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

48. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

49. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

50. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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Graphics View Window 

Graphics View Basics 

What is the Graphics View? 
FARO Insight Visual and VisualPro have an additional window called the Graphics 
View.  This view enables you to view all actual and nominal features in a three 
dimensional graphical representation.  This makes for easier visualization of your 
job, as well as allowing for an array of additional analysis tools that can be used for 
checking the quality of actual features or comparing actual and nominal features and 
surfaces. 

World Orientation Axis 
Located in the upper left corner of the graphics window is a coordinate axis 
representation called the World Orientation Axis.   

 
Graphics View with World Orientation Axis 

This orientation axis displays the current view orientation within the graphics 
window.  While the view is being rotated, the axes will also rotate.  This 
representation gives the user a constant reference to the currently viewed orientation. 
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Navigating through the Graphics View 

Selecting Features 
To select a feature, or make it the active feature, choose it from the Gents 
Worksheet, or click on it in the Graphics View.  You can choose more than one 
feature in the Graphics view by selecting the first feature and holding the CTRL key 
down when selecting subsequent features.  When selecting from the Graphics View, 
if there is one or more features overlapping, or if features are very close together in 
the chosen area, the following dialog will appear, allowing the user to choose which 
feature to select from a list. 

 

From this dialog, you can select the feature or features you want to activate.  You 
can choose multiple features by using the CTRL key or the SHIFT key while 
pressing the mouse button. 

Speed Menu 
Like the Gents Worksheet, the Graphics View has a speed menu that allows you to 
quickly access commonly used functions.  The speed menu works only on the active 
feature.  To display the speed menu, first select a feature, then press the right mouse 
button in the Graphics View.  The following menu will appear. 

 

Deviations 

Observations 

Statistics… 

Normal 

Flip Normal 

Edit Functions… 

Edit Properties… 

Delete 

Tracker Measure 

Theodolite Measure 

Aim 

Create Nominal Points 

View 

Shows or hides the active feature’s deviations. 

Shows or hides the active feature’s observations. 

Shows the Statistics Information window. 

Shows or hides the active feature’s normal vector. 

Assigns the Flip Normal function to the active feature. 

Opens the edit Functions dialog for the active feature. 

Opens the edit Properties dialog for the active feature. 

Deletes the active feature. 

Takes a measurement for the active feature. 

Takes a measurement for the active feature. 

Aims at the active feature. 

Creates nominals points on the feature’s surface. 

Opens the View menu. 
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Editing observations with polygon select 
FARO Insight Visual allows you to edit point clouds while in the Graphics View by 
using the Polygon Select command.  This feature allows you to use the mouse to 
select an area and un-use or delete the observations of a feature. 

41. From the Graphics menu, select Point Cloud, then Modify by Polygon 
Select… (Alt, G, P, M).  This option is only available when the active 
feature’s observations have been selected to be shown in the Graphics 
window. 

42. The mouse cursor will now display a pencil when it is over the 
Graphics View.  Press the mouse button near where you want to start 
the selection process.  Drag the mouse to the second corner of the 
polygon and press the mouse button again and repeat this for the third, 
fourth, etc.  Double click to connect the last corner to the first corner. 

For example, if you want to select the following observations, press the 
mouse button in the following locations. 

When you are done selecting, the Polygon Select Options Dialog will 
be displayed. 
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Polygon Select Options Dialog 

43. From the Polygon Select Options Dialog, choose from the following 
options: 

All Visible Clouds – Select this to have Polygon Select work on all 
features that are currently visible in the Graphics View. 

Active Cloud Only – Select this to have Polygon Select work only on 
the active cloud(s). 

Inside Polygon – Select this to have Polygon Select work only on the 
points inside the polygon. 

Outside Polygon – Select this to have Polygon Select work only on 
the points outside the polygon. 

Delete Selected Points – Select this to have Polygon Select delete 
all the selected observations from the FARO Insight database. 

Un-use Selected Points – Select this to have Polygon Select un-use 
all the selected observations. 

44. Click ‘OK’ when done. 

When you create a closed area using the polygon select, you are creating an inside 
and an outside.  When you select around an already closed area, the inside area now 
becomes the area between the two boxes.  In the following example, the shaded area 
is the inside. 
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Controlling View 
Just as the Geometric Entities sheet can be viewed in many different ways, so can the 
Graphics View.  With the Graphics View Toolbar (shown below) and items from the 
Graphics menu, you can view specific types of features, zoom in or out on certain 
features, rotate or pan the view, etc.  Using these commands, you should be able to 
view measured features in a manner that is most appropriate to your needs. 

 
The Graphics View Toolbar 

Displaying Features 
Just as the Gents Worksheet has filters that enable you to view features of only one 
type (circles, spheres, etc) or only one set (Actual or Nominal), the Graphics View 
allows you to do the same. 

The Feature Type filter and the Set filter are the first two items in the Graphics View 
Toolbar.  To use them, click on the arrow on the right side of the filter, then select 
the feature type, or set, that you want to view from the drop down list. 

 

Another way to show a certain type of features is by using the Show and Hide 
commands.  By selecting Graphics, Feature, Show from the menu bar (Alt, G, F, S), 
you get the following menu. 

 

All 
All Surfaces 
All Curves 
Active Only 

Shows all features. 
Shows cylinders, planes, paraboloids, and spheres. 
Shows circles, lines, and points. 
Shows only the Active Feature(s). 
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Choosing Graphics, Feature, Hide (Alt, G, F, H) results in a similar menu, but hides 
features instead of showing them. 

Both the filters and the Show/Hide commands from the menu bar work on all 
features.  Features can be shown or hidden on an individual basis through their 
Properties.  See “Feature Display Options” for more information. 

Displaying Labels 
FARO Insight Visual makes it easier to determine what each feature is in the 
Graphics View by giving you the option to display Labels.  A label is the name of 
the feature displayed next to its graphical representation.  To display labels, choose 
Graphics, Feature, then Labels from the menu bar (Alt, G, F, L).  To hide the labels, 
choose this menu item again.  When labels are displayed, a check mark will appear 
next to this menu item. 

The Labels command from the menu applies labels to all features.  A features label 
can be displayed on an individual basis through its Properties.  See “Feature Display 
Options” for more information. 

Zooming In and Out 
Zooming in and out is changing the view by adjusting the magnification factor or 
display scale.  By doing this, you can either view a large portion of your job at a 
lower magnification factor or view only one or two features with a high level of 
detail at a larger magnification factor. 

Zooming in and out can be done both by the Graphics menu and by the Graphics 
View Toolbar.  Below are the Graphics View Toolbar buttons that control display 
scale. 

 

Zoom In Increase the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Out  Decrease the magnification of the Graphics View by a 
factor of 2. 

 

Zoom Box  Enclose a box around the desired features to be 
displayed.  Graphics View zooms in on those features. 

 

Zoom All  Adjust the Graphics View so that all features are 
displayed. 

The Zoom In, Zoom Out, Zoom Box, and Zoom All commands can all be accessed 
by selecting Graphics, Zoom (Alt, G, Z) from the menu bar. 

Another way to adjust the view is by manually adjusting the Zoom Factor.  The 
Zoom Factor is how many times the Graphics View will be scaled up or down.  With 
the Zoom Factor set to 1, one unit in model space will be mapped to 1 pixel on the 
screen.  With the Zoom Factor set to 100, one unit in model space will be mapped to 
100 pixels on the screen.  To set the Zoom Factor, select Graphics, Zoom, then 
Factor (Alt, G, Z, F) from the menu bar.  The View Zoom Factor Dialog will be 
displayed. 
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Zoom Factor Dialog 

Enter the new Zoom Factor and click the ‘OK’ button. 

As you zoom in and out of the Graphics View, you are adjusting the Dimension 
Scale.  The Dimension Scale, shown in the lower left-hand corner of the Graphics 
View, has two small vertical lines connected by a long horizontal line.  Next to this 
is a number.  This number represents how far the distance between the two vertical 
lines on the screen represents in the current unit of length you are working in.  
Zooming in, or increasing the magnification, decreases the Dimension Scale and 
zooming out, or decreasing the magnification, increases the Dimension Scale. 

View Orientations 
Another aspect of the Graphics View is orientation, or the angle at which the features 
are being viewed.  FARO Insight Visual provides several predefined views to choose 
from, as well as allowing the user to manually rotate or translate the view. 

Preset Views 
FARO Insight Visual has seven preset views from which you can choose.  All of the 
views can be selected using the Graphics View Toolbar or the menu bar.  Below is a 
list of the preset views FARO Insight Visual provides and their icon on the Graphics 
View Toolbar. 

 

Top View View the Graphics View Window looking down the 
+Z axis of the current coordinate system. 

 

Bottom View View the Graphics View Window looking down the -
Z axis of the current coordinate system. 

 

Front View  View the Graphics View Window looking down the 
+X axis of the current coordinate system. 

 

Back View View the Graphics View Window looking down the -
X axis of the current coordinate system. 

 

Left View View the Graphics View Window looking down the -
Y axis of the current coordinate system. 

 

Right View View the Graphics View Window looking down the 
+Y axis of the current coordinate system. 

 

Isometric View View the Graphics View Window looking down from 
first quadrant of the current coordinate system (all 
axis positive direction towards you). 
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These preset views can also be accessed by selecting Graphics, then View (Alt, G, 
V) from the menu bar. 

Rotation 
Sometimes, it is difficult to see important features clearly after selecting one of the 
preset views.  In this situation, it is possible to rotate the view slightly so that those 
features can be inspected. 

Before you can rotate the view, you must set Pivot Point, or a point about which you 
are going to rotate.  You can set the pivot point to one of two places, the World 
Center or the Active Feature Center.  Setting the pivot point to the World Center will 
allow you to rotate about the center of the current Graphics View.  Setting the pivot 
point to the Active Feature Center will allow you to rotate about the center of the 
active feature. 

You can set the pivot point using either the Graphics Settings Feature toolbar or the 
menu bar.  To set the pivot point to the World Center, either press the button, , or 
choose Graphics, Set Pivot Point To, World Center (Alt, G, T, W) from the menu.  
This button will be depressed and there will be a check mark next to the menu item 
to confirm the pivot point has been set.  Note that each time a new feature is made 
active, this button must be reactivated in order to lock on to that feature.  To set the 
pivot point to the Active Feature Center, either press the button, , or choose 
Graphics, Set Pivot Point To, Active Feature Center (Alt, G, T, F) from the menu.  
Once again, this button will be depressed and there will be a check mark next to the 
menu item to confirm the pivot point has been set. 

Once the pivot point has been set, you need to tell the FARO Insight Visual that you 
are going to use the mouse to rotate the Graphics view.  This is done by making the 
Graphics view the active window, and then by pressing the SHIFT key.  The mouse 
pointer will change to a  symbol.  In this mode, holding the left mouse button 
down while moving the mouse will cause the graphics View to rotate in whichever 
direction you move the mouse.  For example, if you want to view the current display 
from above, move the mouse up. 

Translation 
Sometimes, as a result of zooming and rotating, features of interest may have drifted 
out of boundaries of the Graphics View.  To bring the features back into the display 
range, you must translate, or Pan, the view left, right, up or down.  This can be done 
with either the mouse or the keyboard. 

To translate the Graphics View with the keyboard, press the corresponding arrow 
key.  For example, if the feature of interest is only partially visible at the bottom of 
the screen, you need to translate the view up, so you would press the up arrow. 

To translate the view using the mouse, you need to tell the FARO Insight Visual that 
you are going to use the mouse to translate the Graphics view.  This is done by 
making the Graphics view the active window, and then by pressing the CRTL key.  
The mouse pointer will change to a  symbol.  In this mode, holding the left mouse 
button down while moving the mouse will cause the graphics View to translate in 
whichever direction you move the mouse. 

View Orientations for a Feature 
The Graphics View Toolbar and the Graphics menu give the ability to activate a 
preset orientation for the current frame or coordinate system.  An easy way to view 
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an individual feature with closer detail is to adjust the view orientation about that 
detail.  Doing this will also adjust the display scale so that the feature fills the 
Graphics View display.  To change orientation about an individual feature, activate 
the feature and select View from the Graphics View Speed Menu.  A second menu 
will appear, allowing you to view that feature from the Top, Bottom, Front, Back, 
Left, Right, or Isometric views. 

Surface Shading 
For features such as planes, spheres, cylinders, etc, FARO Insight Visual displays 
them as wireframes or meshes by default.  This is desirable for most uses, but there 
may be times when a more presentable representation is desirable.  Typically, when 
you want to print your results out to a printer for a report.  This can be done through 
the use of Surface Shading.  Surface shading will take the wireframe and mesh 
representations and give them a solid, three-dimensional appearance.  Two colors 
will be used for shading, gray and purple.  Gray will be used to denote the features 
outside, or the positive side of a feature with a normal vector.  Purple will be used to 
denote the features inside, or the negative side of a feature with a normal vector. 

You can display shading by either pressing the Toggle Surface Shading button, , 
from the Graphics View Toolbar or by choosing Graphics, then Shading (Alt, G, H) 
from the menu bar.  After surface shading has been created, you can turn it on or off 
by again pressing the Toggle Surface Shading button, on the Graphics View Toolbar 
or by choosing Graphics, Shading (Alt, G, H) from the menu bar. 

Color Display 
The Graphics View has default colors for features or items with different 
characteristics.  These default colors make it easier to determine what features are 
actuals or nominals, which feature is the active feature, which deviations are in or 
out of tolerance, etc.  FARO Insight Visual also gives you the ability to change these 
colors to suit personal preferences. 

To change the color display, choose Settings, then Colors (Alt, S, L) from the menu 
bar.  FARO Insight Visual will display the Display Colors Dialog. 

 
Color Settings Dialog with Feature Colors Tab selected 

From the Tolerance Colors tab, the user can select four fields for deviations displays: 
Positive Out of Tolerance, Negative Out of Tolerance, Positive In Tolerance, and 
Negative In Tolerance. 

From the Feature Colors tab, the user can select four filed for feature displays: 
Nominals, Actuals, Active Feature, and Observations. 
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Display Thickness 
The Display Thickness, or how thick features appear in the Graphics View, can also 
be changed.  This can sometimes make it easier to distinguish between features. 

To change the display thickness, choose Graphics, then Thickness (Alt, G, T) from 
the menu bar.  FARO Insight Visual will display the Display Thickness Dialog. 

 
Display Thickness Dialog 

There are three fields that may be adjusted: Features, Point Clouds, and Deviation 
Clouds.  Each of these fields may be changed by either clicking on the up/down 
arrows directly to the right of the open field or by simply typing in the desired size. 

Feature Display Options 

Editing Properties 
When a feature is created, it has a set of default properties that control how it will be 
displayed in the Graphics View.  Throughout a job, it may be necessary to change 
these properties for ease of viewing or analysis.  After a feature has been created, its 
properties can be changed at anytime by using the Edit Properties Dialog. 

The Edit Properties Dialog can be opened in several different ways.  You can select 
Edit Properties from the Speed Menu (accessed by right clicking on the feature in the 
Gents sheet or the Graphics View), press the Edit Properties button, , from the 
Standard Toolbar, or select Edit, Properties (Alt, E, T) from the menu bar. 
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The Edit Properties Dialog 

The Edit Properties Dialog has four distinct tabs (five for Points).  The Display tab 
controls how the feature is displayed in the Graphics View.  The Tolerance tab 
allows a tolerance to be applied to the feature.  This tolerance can be used for 
analysis in the Graphics View.  The Data tab shows the X, Y, Z, I, J, K, and radius 
values of the feature.  These values correspond to what is displayed in the Gents 
sheet.  The Calculation tab allows the user to filter out observations so that either the 
Front Sight, Back Sight, or both types of observations are used to calculate the 
feature.  

Display Properties 
The Display Properties tab controls how the feature will be shown on the Graphics 
View.  A brief description of each option follows. 

Mesh Type – Controls the type of mesh used to display the feature.  May be 
Adaptive or Uniform.  See “Displaying Surfaces” for more information. 

Surface Display Type – Controls the type of surface displayed in the Graphics 
View.  See “Displaying Surfaces” for more information. 

Color – Changes the display color of the feature in the Graphics View. 

Segment Density – Changes the number of segments used to display a Uniform 
Wireframe.  See “Displaying Surfaces” for more information. 

Segments – Changes the number of segments used to display a Uniform Mesh.  
See “Displaying Surface” for more information. 

Chord Height – Changes the display tolerance used to display an Adaptive surface.  
See “Displaying Surfaces” for more information. 
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Show Label – Displays the features name in the Graphics View. 

Show – Displays the feature in the Graphics View. 

Hide – Hides the feature from the Graphics View. 

Displaying Surfaces 
In FARO Insight Visual, cylinders, paraboloids, planes and spheres are considered 
surfaces.  Surfaces can be displayed in the Graphics View in several different ways.  
Sometimes, it may be necessary to change the way in which these surfaces can be 
viewed.  For example, sometimes it may be desirable to display a surface can be 
displayed with finer precision for presentation purposes, but set to a lower precision 
to speed up screen displays. 

When a surface is displayed on the screen, it is shown as a series of segments, or 
mesh, that approximates the actual surface.  Changing how the surface is displayed is 
actually defining how the surface is broken down into these segments (Mesh Type) 
and how they are displayed on the screen (Surface Display Type).  In the picture 
below, a surface has been simplified as a curve to show how it is displayed on the 
screen. 

 

There are two Mesh Types, Uniform and Adaptive.  A Uniform Mesh is one in 
which the user can manually enter the number of segments used to approximate the 
surface.  Depending on the Surface Display Type, Segments are either defined in 
the Segment’s u, v field or the Segment Density.  More segments mean the surface 
displayed will be of higher accuracy, but take longer to display on the screen. 

An Adaptive Mesh is one in which the computer will calculate the number and 
distribution of the segments used to approximate the surface based on the Chord 
Height.  The Chord Height, which is defined by the user, is a tolerance value.  The 
mesh is calculated so that distance between the curve of the actual surface and the 
segment of the approximated surface never deviate from a value greater than that 
amount.  The chord height is defined in the units of length you currently have FARO 
Insight Visual set to.  A lower chord height means the surface displayed will be of 
higher accuracy, but take longer to display on the screen. 

After choosing the Mesh Type, the Surface Display Type needs to be defined.  There 
are three types to choose from, Wireframe, SurfaceMesh and TrimmedMesh.  For all 
features in FARO Insight Visual, there is no difference between SurfaceMesh and 
TrimmedMesh.  A Wireframe is the simplest display type.  It essentially breaks the 
feature down so that the features surface is not immediately apparent.  A 
SurfaceMesh displays a grid that represents the features surface. 

Following is a series of cylinders, displayed in different combinations of Uniform, 
Adaptive, Wireframe and SurfaceMesh. 
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Uniform Mesh – Wirframe Display 

Left:  Segment Density of 4 

Right:  Segment Density of 8 

 
Uniform Mesh – SurfaceMesh Display 

Left:  Segments U of 4, Segments V of 2 

Right:  Segments U of 8, Segments V of 4 
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Adaptive Mesh – SurfaceMesh Display 

Left:  Chord Height of 0.3 inches 

Right:  Chord Height of 0.15 inches 

Increasing and Decreasing Smoothness 
The Smoothness of a surface refers to the amount of detail displayed in the Graphics 
View.  This can be set on a feature by feature basis by changing the chord height or 
the segments in the Properties page, but it is sometimes useful to do this for the 
entire display at once.  To increase the smoothness of all features (lower chord height 
or more segments) press the Increase Smoothness button, , on the Graphics 
Settings Toolbar.  To decrease the smoothness of all features (increase the chord 
height or fewer segments) press the Decrease Smoothness button, , on the 
Graphics Setting Toolbar.  Using these buttons does not permanently change a 
feature's smoothness setting, after a recalculation; the features will revert back to 
their original settings. 

Viewing Observations 
FARO Insight Visual allows you to view the measured observations used to create a 
feature.  This is useful for analysis and, when used in conjunction with the Polygon 
Select function, is useful for deleting or un-using observations.  Observations can be 
viewed by selecting the feature and choosing Observations from the Speed Menu in 
the Graphics View, pressing the Observations button, , from the Graphics Active 
Feature Toolbar, or choosing Graphics, Active Feature, Observations (Alt, G, A, O) 
from the menu bar. 

Viewing Normals 
FARO Insight Visual has the option to display a features normal vector in the 
Graphics View.  This can be useful for determining which offset to use or when 
using a features vector in a function (such as using a planes vector in a frame).  To 
display a features normal vector, select the feature and press the Show Normals 



FARO Insight 5.0 User's Guide Graphics View Window  •  349 

button, , from the Graphics Active Feature Toolbar, select Graphics, Active 
Feature, Normal (Alt, G, A, N) from the menu bar, or select Normal from the 
Graphics View Speed Menu. 

NOTE:  For a circle, cylinder and a sphere, the radial direction will be shown 
instead. 

Deviation Display 
FARO Insight Visual provides many ways to view the deviations of both measured 
observations to its fit feature and actual features to their corresponding nominal. 

Viewing Deviations 
The deviations of a feature can be displayed by selecting the feature pressing the 
Deviations button, , from the Graphics Active Feature Toolbar, choosing 
Graphics, Active Feature, Deviations (Alt, G, A, D) or choosing Deviations from the 
Graphics View Speed Menu. 

There are four display modes for a deviation cloud, Point, Spike, Connect, and Spike 
& Connect.  When the display mode is set to Point, the end point of each deviation 
vector will be displayed.  When set to Spike, the deviation vector is displayed.  
When set to Connect, a line connected each end point is displayed.  When set to 
Spike & Connect, both a line connecting the endpoints and the deviation vector are 
displayed. 

The display mode can be set from the Graphics, Deviation Cloud, Display Mode 
menu (Alt, G, D, Y).  The Graphics Settings Toolbar can also be used.  For Spikes, 
press , for Connected Points, press , and for Spikes and Connected Points, 
press . 

Deviation Display Scale 
Because deviations are much smaller than the size of what is being analyzed, they 
have a display scale independent of actual and nominal features.  The current 
deviation display scale can be displayed in the lower right hand corner of the 
Graphics View from the Graphics, Scale, Deviation (Alt, G, S, V) from the menu 
bar. 

For easier viewing, the deviations can be magnified by pressing the Magnify 
Deviations button, , on the Graphics View Toolbar or by selecting Graphics, 
Deviation Cloud, Magnification, Magnify (Alt, G, D, M, M) from the menu bar.  The 
deviations can be de-magnified by pressing the Demagnify Deviations button, , 
on the Graphics View Toolbar or by selecting Graphics, Deviation Cloud, 
Magnification, Demagnify (Alt, G, D, M, D) from the menu bar. 

The display scale can also be set manually by selecting Graphics, Deviation Cloud, 
Magnification, Magnification Factor (Alt, G, D, M, F) from the menu bar.  This will 
display the Set Magnification Dialog. 
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Set Magnification Factor Dialog 

The Deviation Scale is always current Dimension Scale divided by the Magnification 
Factor.  If the Dimension Scale is 1.0 and the Magnification Factor is 0.5, the 
Deviation Scale would be 2.0.  If the Dimension Scale is 1.0 and the Magnification 
Factor is 2, the Dimension scale would be 0.5. 

Deviation Statistics 
When the deviations for a feature are displayed, the ability to view Deviation 
Statistics is available.  This is useful for evaluating the fit of a sphere, checking 
flatness of a measured plane, or comparing a nominal feature to an actual feature. 

The Deviations Statistics for a feature, or set of features, can be viewed by clicking 
the Deviations Statistics button, , on the Graphics Active Feature Toolbar or by 
choosing Graphics, Active Feature, then Statistics (Alt, G, A, S) from the menu bar 
or by choosing Statistics from the Graphics View Speed Menu. 

 
Statistics Information Dialog 

This dialog shows useful statistical information including the total number of points, 
number of points in and out of a specified tolerance, max and min deviations, 
bandwidth, average deviation and the Root Mean Square (RMS). 

The Deviation Statistics can be viewed from an actual or a nominal feature.  The 
statistics shown from an actual feature are calculated from the deviations between 
the measured observations used to create the actual feature and the actual feature 
itself.  The statistics shown from a nominal feature are from the deviations of the 
measured observations to the nominal feature. 
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The Statistics from Polygon Select command from the Graphics, Deviation Cloud 
(Alt, G, D, S) menu allows you to view the deviation statistics from an are chosen 
using the Polygon Select command. 

Deviation Max and Min 
The maximum and minimum deviations of a feature can be marked in the Graphics 
View by selecting Graphics, Deviation Cloud, Mark Max/Min Deviations (Alt, G, D, 
K) from the menu bar.  This will display a marker on top of the maximum and 
minimum deviations of each feature.  This is useful for determining where high or 
low spots are and for determining bad observations. 

Setting a Tolerance 
A Tolerance can be added to each feature through its Edit Properties Dialog.  When 
used with the Deviation Statistics, this tolerance is useful in determining the quality 
of your measurement or the position of your details. 

To add a Tolerance to a feature, select it and open its Edit Properties Dialog.  Select 
the Tolerance tab and enter an Upper and Lower Tolerance in the units you are 
currently working in.  Click ‘OK’ when you are done.  Following is an Upper and 
Lower tolerance of 0.25 millimeters applied to a feature. 

 
An Upper and Lower Tolerance of 0.25 millimeters 

In the Statistics Information Window, the number of points that are out of the entered 
tolerance will be displayed in the Out of Tolerance row.  In the Graphics View, the 
colors of In Tolerance observations and Out of Tolerance observations will be 
determined by the settings in the Display Colors dialog.  See “Color Display” for 
more information. 
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Deviation Color Bar 
Another feature in FARO Insight is the Deviation Color Bar, a visual representation 
of a deviation plot's statistics.  This bar will be displayed any time the user chooses 
to display a feature's deviations in the Graphics View.  The displayed bar will 
correspond to the active feature that has its deviations displayed, therefore it may or 
may not be for the active feature.  The bar, shown below, corresponds to the colors 
for deviation spikes and displays the highest and lowest deviations, as well as the 
percentage of observations in each zone of the bar.  Additionally, if there is a 
tolerance applied to the feature, the deviation bar will display the upper and lower 
tolerance with the percentage of observations in and out of tolerance. 

 
Deviation Color Bar 

Watch Windows with a Tolerance 
FARO Insight Visual uses any tolerance associated with a feature inside of a Watch 
Window.  This can be useful when using a watch window on a plane.  When the 
normal deviation is greater than a specified tolerance, the watch window display 
changes color. 

Doing the following can open a watch window with a tolerance: 

21. Select a feature, and use the Edit Properties dialog to set an upper and 
lower tolerance to a feature. 

22. While the feature is selected, open a watch window by pressing F4, 
pressing the Watch Window button, , on the Tracker Toolbar, or 
selecting View, Watch Window (Alt, V, W) from the menu bar. 

The displayed colors in the watch window will correspond with the 
color settings set in the Display Colors Dialog.  See “Controlling View” 
for more information.  In the Graphics View, deviation spikes 
corresponding to each watch component will appear.  The color of each 
deviation spike will correspond to the applied tolerance.  The type of 
spike (3D or X, Y, Z component) is configurable through the Watch 
Setting Dialog.  See the “Watch Windows” section in the “FARO 
Insight Worksheets” Chapter for more information. 
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Build Mode 
Inside of the Watch Settings dialog box, which is accessed by selecting Watch from 
the Settings menu (Alt, S, W), exists a “Build Arrows” check box.  Checking this 
box places the watch window and graphics view in Build Mode. 

 
Watch Settings Dialog with the Build Arrows Option Checked 

Build Mode displays arrows in the Graphics View in addition to the deviation spikes.  
The arrows will be pointing in the direction towards the feature being watched, thus 
if a watch window is opened on a nominal point, the arrows will indicate what 
direction the target needs to be moved to be in the nominal position.  If the arrow is 
perpendicular to the Graphics View’s orientation, then either a “” or a “+” will be 
displayed.  A “” indicates that the arrow is coming out of the screen and a “+” 
indicates that the arrow is going into the screen. The Watch Window and the 
Graphics View will display deviation colors based on the feature’s tolerance.  The 
arrow and spike combination only displays one color dependant on if it is in or out of 
tolerance. 

The Arrow Length and the Arrow Line Width can be adjusted from within the Watch 
Settings dialog box to make viewing from a distance easier.  See the “Watch 
Windows” section in the “FARO Insight Worksheets” Chapter for more information. 

 
Component Deviations Shown in Watch and Graphics with Build Arrows 
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Exporting from the Graphics View 

Exporting Point Clouds 
Point Clouds and the observations of a feature can easily be exported out of FARO 
Insight Visual using the Graphics View windows.  Point Cloud observations may be 
exported as raw data (no offset) or with an offset adjustment.  This can be useful for 
taking measured data to a CAD program or CATIA. 

To export a point cloud or a set of observations, the Graphics View must be open. 

61. Set the display parameters to the proper Frame and Condition.  (PART 
Frame, REFERENCE Condition). 

62. If observations of a measured feature are to be exported, display the 
feature’s observations in the Graphics View. 

63. Select File, Export, Point Clouds, then Text (Alt, F, E, P, T) from the 
menu bar.  The Export Point Clouds Dialog will be shown. 

 
The Export Point Clouds Dialog 

64. Choose the features to be exported from the list box on the left-hand 
side.  An “_Obs” extension is shown after features other than Point 
Clouds. 

65. Choose the appropriate Output Options 

Header – Puts a header at the top of file. 

Point No. – Puts the point number in the first column of the file. 

X Coord – Prints out the X value. 

Y Coord. – Prints out the Y value. 

Z Coord – Prints out the Z value. 

Delimiter – Comma or Space, set the character between each column. 

66. Press ‘OK’ when done selecting. 

FARO Insight Visual will display a File Save As dialog.  You can name 
the file and put it in whatever directory you choose. 

Note:  FARO Insight VisualPro is capable of exporting data as an IGES file.  See the 
Chapter entitled “FARO Insight VisualPro” for more information. 
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Creating Nominal Points 
FARO Insight Visual has the ability to create nominal points from features other than 
a point.  A nominal point can be created from a feature by doing the following. 

51. You must set the viewing conditions to REFERENCE and the proper 
frame (i.e. PART). 

52. The name of the nominal points will come from the Feature Toolbar 
Set the Feature Toolbar to create a nominal point and enter the 
appropriate name in the Proposed Name field.  See the “Declaring 
Features” section in the “FARO Insight Worksheets” chapter for more 
information. 

53. Set the feature creating the Nominal points to be the active feature.  
Choose Create Nominal Points from the Graphics View Speed Menu or 
choose Graphics, Point Clouds, Create Nominal Points (Alt, G, P, N) 
from the menu bar. 

54. The mouse pointer will become a small hand.  Press the mouse button 
on the surface where the nominal point is to be created. 

55. When done, choose Create Nominal Points from the Graphics View 
Speed Menu or choose Graphics, Point Cloud, Create Nominal Points 
(Alt, G, P, N) from the menu bar. 

Printing the Graphics View 
All or part of the Graphics View can be printed out on a printer for a final report if 
needed.  FARO Insight Visual will print whatever is displayed in the Graphics View.  
Selecting File, Print Preview (Alt, F, V) from the menu bar can see a preview of 
what will be printed.  To print the Graphics View, select File, then Print (Alt, F, P) 
from the menu bar. 
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